# Table of Contents

**Chapter 1 Using this Guide**

Who Should Read this Guide ................................................................. 1

How to Use this Guide ........................................................................... 2

Getting Help ............................................................................................ 2

  Documentation and Learning Resources ............................................. 2

  Technical Support .................................................................................. 3

  Community ................................................................................................ 3

Blackboard Collaborate Product Feedback ............................................ 3

Conventions Used in this Guide .............................................................. 3

  Variables .................................................................................................. 3

  Notes ........................................................................................................... 4

  Typographical Conventions ................................................................. 4

  Operating System Differences ............................................................ 5

  Keystrokes and Mouse Clicks ............................................................... 5

  Screen Captures .................................................................................... 5

**Chapter 2 Getting Started** ................................................................. 7

Minimum Client System Requirements .................................................. 8

Joining a Blackboard Collaborate Web Conferencing Session ................ 8

Setting Your Proxy Configuration .......................................................... 8

**Chapter 3 The Blackboard Collaborate Web Conferencing Room** .......... 13

The Content Area Modes ....................................................................... 16

The Menus ............................................................................................... 17

  Menus in the Main Menu Bar ............................................................... 17

  Drop-Down Menus ............................................................................... 18

Closing the Application .......................................................................... 19

  The Confirmation Dialog ..................................................................... 19

**Chapter 4 Attending Sessions on Mobile Devices** ................................. 21

**Chapter 5 The Participants Panel** ....................................................... 23

Understanding Permissions .................................................................... 24

  Permission Indicators in the Participants List ..................................... 26

  Viewing all of your Permissions ......................................................... 27

Knowing When Someone has Joined or Left a Session ......................... 27
## Raising and Lowering Your Hand

- Raised Hand Notification

## Stepping Away

- Stepping Back

## Entering Feedback

## Activity Indicators

- Status Indicators

## Polling

- Viewing Polling Results

## User Profiles

- Viewing a User's Profile
- Editing Your User Profile
  - Importing a vCard file
  - Exporting a vCard file

## Mobile Device Indicators

### Chapter 6 Video

- Video Activity, Permission and Status Indicators
- Activity and Permission Indicators
- Status Indicators
- Previewing and Transmitting Video
  - Previewing Video
  - Transmitting Video
  - Stopping Video Transmission
- Selecting your Video Camera
- Viewing Video
- The Default Views

## Multiple Simultaneous Cameras

- Controlling the Primary Video Display
  - Make Video Follow Moderator Focus
  - Make Video Follow Speaker
  - Manually Selecting What to Display
- Stopping Video Transmission

### Chapter 7 Chat

- Chat Activity and Permission Indicators

---

Table of Contents
Chapter 8 Audio ................................................................. 63
Audio Activity, Permission and Status Indicators .................. 65
Activity and Permission Indicators ...................................... 65
Status Indicators .............................................................. 65
Basic Audio Configuration .................................................. 66
Using the Audio Setup Wizard ............................................ 66
On Windows or Linux ......................................................... 66
On Mac OS X ................................................................. 67
Using Your Microphone ....................................................... 68
Adjusting Microphone and Speaker Levels ......................... 69
Microphone Level ............................................................ 69
Speaker Level ................................................................. 70
Chapter 9 The Whiteboard .................................................. 71
Whiteboard Activity and Permission Indicators .................... 73
Adding Content to the Whiteboard ..................................... 73
The Tools Palette ............................................................. 73
The Properties Editor ......................................................... 74
Inserting Text ................................................................. 75
Inserting Graphics ............................................................ 77
Inserting Clip Art Images .................................................. 78
Inserting Screen Captures .................................................. 79
Pointing to Things on the Whiteboard ................................. 80
Setting Whiteboard Preferences ........................................ 80
Chapter 10 Application Sharing

Application Sharing Activity, Permission and Status Indicators ........................................... 96
Activity and Permission Indicators ....................................................................................... 96
Status Indicators ................................................................................................................... 96
Viewing a Shared Application ............................................................................................. 97
Scaling the Shared Content ................................................................................................. 97
Maximizing the Content Area .............................................................................................. 98
Emphasized Cursor .............................................................................................................. 98
Hosting an Application Sharing Session ............................................................................ 98
Application Sharing Mode ................................................................................................... 98
Starting an Application Share ............................................................................................ 99
The Host’s View of Application Sharing ............................................................................ 101
Controlling an Application Share ....................................................................................... 102
Pausing and Resuming an Application Share ................................................................. 102
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previewing an Application Share</td>
<td>102</td>
</tr>
<tr>
<td>Taking a Snapshot</td>
<td>103</td>
</tr>
<tr>
<td>Giving Control of an Application Share to Another</td>
<td>103</td>
</tr>
<tr>
<td>Delegating Remote Control</td>
<td>104</td>
</tr>
<tr>
<td>Granting a Request for Control of an Application Share</td>
<td>104</td>
</tr>
<tr>
<td>Revoking Control</td>
<td>105</td>
</tr>
<tr>
<td>Stopping an Application Share</td>
<td>105</td>
</tr>
<tr>
<td><strong>Chapter 11 Web Tour</strong></td>
<td>107</td>
</tr>
<tr>
<td>Web Tour Mode</td>
<td>108</td>
</tr>
<tr>
<td>Web Tour Activity and Permission Indicators</td>
<td>108</td>
</tr>
<tr>
<td>Starting a Web Tour</td>
<td>109</td>
</tr>
<tr>
<td>Conducting a Web Tour</td>
<td>109</td>
</tr>
<tr>
<td>The Follow Me Option</td>
<td>110</td>
</tr>
<tr>
<td>Publishing URL to Chat Panel</td>
<td>110</td>
</tr>
<tr>
<td>Stopping the Web Tour</td>
<td>110</td>
</tr>
<tr>
<td>Viewing a Web Tour</td>
<td>110</td>
</tr>
<tr>
<td>Optimizing the Content Area</td>
<td>111</td>
</tr>
<tr>
<td><strong>Chapter 12 Interactive Recordings</strong></td>
<td>113</td>
</tr>
<tr>
<td>Playing a Recording</td>
<td>114</td>
</tr>
<tr>
<td><strong>Blackboard Collaborate Copyright</strong></td>
<td>117</td>
</tr>
<tr>
<td><strong>Trademarks</strong></td>
<td>117</td>
</tr>
</tbody>
</table>
Chapter 1

Using this Guide

This guide provides information on the most widely used features of Blackboard Collaborate web conferencing – those features most essential to conducting a Blackboard Collaborate session. For information on all the features, refer to the full Participant's Guide.

Who Should Read this Guide

This guide is written for all those who are attending Blackboard Collaborate web conferencing sessions – Participants.

Blackboard Collaborate Participants need not be computer experts, however, some functions do require basic computer skills such as working knowledge of your operating system, ability to navigate between and within applications, or basic text editing.

Note: Users who make use of the accessibility features in Blackboard Collaborate web conferencing should refer to the Accessibility Guide for Participants.
How to Use this Guide

It is highly recommend that you read the first three chapters of this guide prior to attending a Blackboard Collaborate web conferencing session.

1. Read *Conventions Used in this Guide* on page 3 of this chapter to familiarize yourself with the various presentation, formatting and typographical conventions used in this guide.

2. Follow the instructions in *Getting Started* on page 7 to ensure you have the proper hardware and software to run Blackboard Collaborate and to set up your Blackboard Collaborate environment.

3. Read *The Blackboard Collaborate Web Conferencing Room* on page 13 to familiarize yourself with the Blackboard Collaborate user interface.

Refer to the remaining chapters in any order to become familiar with the available tools and features of Blackboard Collaborate.

**Note:** For a discussion of the accessibility features in Blackboard Collaborate web conferencing, including Closed-Captioning and the Activity Window, see the Accessibility Guide for Participants.

Getting Help

**Documentation and Learning Resources**

Documentation and learning resources (for all Blackboard Collaborate products) are available on the On-Demand Learning Center, which can be reached as follows:

- In your browser, enter the following address:
  
  [http://www.blackboard.com/Platforms/Collaborate/Services/On-Demand-Learning-Center.aspx](http://www.blackboard.com/Platforms/Collaborate/Services/On-Demand-Learning-Center.aspx)

- From within Blackboard Collaborate web conferencing, select *Additional Documentation* from the Help menu.

You can directly open the following documents from within Blackboard Collaborate web conferencing by selecting them from the Help menu:

- Keyboard Shortcuts
- Accessibility Guide for Participants
- Blackboard Collaborate Essentials for Participants
Technical Support
Blackboard Collaborate technical support and the support Knowledge Base are available through the Support Portal:

   http://support.blackboardcollaborate.com

Community
We encourage Blackboard Collaborate users of all levels (administrators, instructors and students) to submit questions to Ask the Doctors, a free question-and-answer forum moderated by an expert team of your fellow Blackboard Collaborate users. Their goal is to provide quality answers to your questions in a highly responsive manner, while building a global knowledge base for online teaching and learning.

   You can find Ask the Doctors at the link below:


   Messages posted in the Ask the Doctors forum do not go to our Support Team. If you require technical support assistance to resolve a problem, please contact Technical Support (see the heading Technical Support in this section).

Blackboard Collaborate Product Feedback
Blackboard Collaborate welcomes your comments and suggestions. If you have an idea for a new feature or enhancement, or would like to send other feedback, please send an email to BBCollaborateFeedback@blackboard.com.

   Your feedback will be sent directly to our Product Management Team.

Conventions Used in this Guide

Variables
There are a few places in Blackboard Collaborate web conferencing that are populated with data specific to the session. Because we do not know in advance what those data (e.g., words or names) will be, in this guide they are represented by variables enclosed in angle brackets. For example, the variable <Panel Name> is used in the discussion of Restoring Default Preference Settings to represent the name of the currently selected panel.
Notes

Six types of notes may be used in this guide to highlight information:

- **Note**: Notes are used to highlight important information or to present asides relevant to the topic at hand.

- **Tip**: Tips provide helpful information on how to most effectively use a particular feature of the product.

- **Caution**: Cautions alert you to potentially confusing terminology or difficulties that may occur when using the product.

- **Warning**: Warnings alert you to potentially serious problems.

- Notes of this format are used to highlight Linux-specific information.

- Notes of this format are used to highlight Mac-specific information.

- Notes of this format are used to highlight information specific to mobile devices (mobile phones and tablets).

Typographical Conventions

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Number</td>
<td>Indicates a step in a task.</td>
</tr>
<tr>
<td>Hollow bullets</td>
<td>Indicates that there are several options available for completing a task, but only one is necessary.</td>
</tr>
<tr>
<td><strong>Bold</strong></td>
<td>Represents clickable elements in the user interface (e.g., text links, buttons, tabs, etc.). Also used to give emphasis to words.</td>
</tr>
<tr>
<td><strong>Italics</strong></td>
<td>Represents menu items, options and parameters. Also used for cross references and names of documents.</td>
</tr>
<tr>
<td>Monospace</td>
<td>Indicates pathnames, filenames, folders and command lines.</td>
</tr>
<tr>
<td>&lt;brackets&gt;</td>
<td>Indicates variables.</td>
</tr>
</tbody>
</table>
Operating System Differences
This guide is written for Blackboard Collaborate web conferencing users on all supported operating systems: Windows, Mac OS X, and Linux.

Keystrokes and Mouse Clicks
The same keystrokes and mouse clicks are used on Windows and Linux platforms. Those used on Mac OS X are different. This guide gives instructions for users of all supported operating systems. The Windows/Linux keystrokes or mouse clicks are given first, followed by those for Mac OS X (in parentheses):

Mouse Click Example
Select the object and then right-click (Control-Click on Mac) anywhere on the Whiteboard to display the context menu.

Keystroke Example
Select the object(s) in the Whiteboard or in the Object Explorer and then enter Ctrl+X (Command-X on Mac) to cut the object(s).

Screen Captures
Most screen captures shown in this guide were taken in a Windows environment. If you are running Blackboard Collaborate web conferencing on a Mac OS X or Linux platform, the appearance of windows, dialog boxes, etc. will differ slightly from those shown in this guide.
Chapter 2

Getting Started

There are a few things you should do before you participate in a session:

1. Ensure your computer meets the minimum system requirements recommended for running a Blackboard Collaborate web conferencing session on your computer. See Minimum Client System Requirements on page 8.

2. Launch into a private Blackboard Collaborate web conferencing session where you can familiarize yourself with the Whiteboard tools or create or review presentations and/or quizzes prior to joining your scheduled session. (For instructions on launching a private session, see the Participant's Guide.)

3. Join a Blackboard Collaborate web conferencing session. You may join a session either through an email link sent to you by your organization or via a link on a web page. The method by which you join a session will vary depending on your organization. See Joining a Blackboard Collaborate Web Conferencing Session on page 8.

4. Once you have successfully launched into a Blackboard Collaborate web conferencing session, run the Audio Setup Wizard (see Using the Audio Setup Wizard on page 66) and set your proxy settings (see Setting Your Proxy Configuration on next page).
Minimum Client System Requirements

Before you can get started in a Blackboard Collaborate web conferencing session, you should ensure that your computer is able to support the needs of the collaboration environment.

**Tip:** For Linux and Mac OS X 10.4 and earlier users, we strongly recommend that you use a headset (or at least headphones or an echo canceling microphone) rather than speakers when using simultaneous talkers. This will eliminate potential echoing and feedback and improve your audio experience.

Please read the minimum system requirements listed on the Support website:
support.blackboardcollaborate.com/ics/support/default.asp?deptID=8336&task=knowledge&questionID=1443

Joining a Blackboard Collaborate Web Conferencing Session

How you join a Blackboard Collaborate web conferencing session varies depending on the organization hosting the Blackboard Collaborate web conferencing session. Follow the instructions provided by the organization hosting your session.

Your System Administrator or Moderator should provide you with the following information:

- How to access your Blackboard Collaborate web conferencing sessions.
- Your username and password (if applicable).
- How to access your recordings.
- Who to contact for help and where to access the user guides and other resource material for your system.

Setting Your Proxy Configuration

If you are connecting through an Internet firewall, which is set up to block both outbound and inbound connections and web browsing that is done through an HTTP or HTTPS proxy server, you may have to change the Proxy Settings preference in Blackboard Collaborate web conferencing.

By default, Blackboard Collaborate inherits the same proxy settings as the browser it was launched through. If Blackboard Collaborate is unable to automatically detect the proxy settings it will be unable to connect to the Session. In this case, you may be able to start Blackboard Collaborate web conferencing but not be able to join a session.

If Blackboard Collaborate encounters a proxy configuration error, it will return a Connection failed error message similar to the one below.
If this happens, you may have to change your Proxy Settings to enable Blackboard Collaborate web conferencing to communicate with your proxy server.

Note: Ask your System Administrator to provide you with the necessary proxy server information.

To Configure your Proxy Settings in the Preferences:

1. Open the Preferences dialog in one of the following ways:
   ◦ From the Edit menu, select Preferences... (Windows & Linux)
     From the Blackboard Collaborate web conferencing menu, select Preferences (Mac OS X)
   ◦ Enter Ctrl+Comma (Windows & Linux)
     Enter Command-Comma (Mac OS X)
2. In the left pane of the Preferences dialog, select *Proxy Settings* under *General*. The Proxy Settings preferences panel appears.

3. Select the desired *Method* option from the Method drop-down list. The choices are the following:

- *Proxy Settings From Launcher (<proxy setting>)* – Blackboard Collaborate uses the connection settings from Java Web Start. If manual proxy settings are not provided to Java Web Start, it will attempt to detect these settings on its own and then pass the results to Blackboard Collaborate. This is the default proxy setting and should be changed only if you are unable to establish a reliable connection.

  **Note:** <proxy setting> will be whichever type of proxy setting is detected by the launcher.

- *Direct Connection* – Specifies that no proxy server is to be used. Blackboard Collaborate web conferencing will connect directly to the appropriate server.

- *SOCKS V4/V5 Proxy Server* – Specifies that a version 4 SOCKS proxy server is to be used.

- *HTTPS Proxy Server* – Specifies that a secure HTTPS proxy server is to be used.

- *HTTP Proxy Server* – Specifies that an HTTP proxy server is to be used.

- *HTTP Proxy Server (Half-Duplex)* – Specifies that an HTTP proxy server is to be used in reduced bandwidth half duplex mode. Use this option only if you have an HTTP proxy server and you are unable to establish a reliable connection with the previous setting.
- **HTTP Direct** – Specifies that Blackboard Collaborate web conferencing is to connect directly to the server with the HTTP protocol. While this is similar to a direct connection, the use of the HTTP protocol may reduce performance and should be used only if a normal direct connection is not possible.

- **HTTP Direct (Half-Duplex)** – Specifies that Blackboard Collaborate web conferencing is to connect directly to the server with the HTTP protocol in a reduced bandwidth half duplex mode. Use this option only if you require an HTTP direct connection and are unable to establish a reliable connection with the previous setting.

4. Enter your proxy server IP address in the *Server* field and enter your proxy server port number in the *Port* field. (You may have to ask your System Administrator to provide you with this information.)

    **Note:** For more information on proxy configuration, visit the Knowledge Base (http://support.blackboardcollaborate.com) and search for "proxy".

5. Click on **OK** to save your preferences and close the Preferences dialog, **Apply** to save your preferences and leave the Preferences dialog open or **Cancel** to close the Preference dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate web conferencing will remember the settings each time you join another session on the same computer.
Chapter 3

The Blackboard Collaborate Web Conferencing Room

The Blackboard Collaborate web conferencing room consists of six main components:

Note: For mobile device users, the Web Conferencing room will not be exactly as described in this chapter. For a discussion of attending sessions on mobile devices, refer to the Mobile User's Guide for your device (iOS or Android) on the On-Demand Learning Center: http://www.blackboard.com/Platforms/Collaborate/Services/On-Demand-Learning-Center/Web-Conferencing.aspx#documentation
<table>
<thead>
<tr>
<th>Term</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio &amp; Video panel</td>
<td>The Audio &amp; Video panel enables you to participate in conversations using either a microphone and speakers (or headset) or via a teleconference. You also can transmit and receive Video during the session and preview your video before transmitting it.</td>
</tr>
<tr>
<td>Participants panel</td>
<td>The Participants panel provides a list of all Participants and Moderators in the session and information about their current activities, such as talking (Audio), transmitting Video, sending a Chat message, using the Whiteboard drawing tools and conducting an Application Sharing session. Above the Participants list is a small toolbar containing buttons for raising your hand and stepping away from the session and menus for selecting polling responses and feedback options.</td>
</tr>
<tr>
<td>Chat panel</td>
<td>The Chat panel enables you to send Chat messages to everyone in the room or to Moderators only. By selecting names in the Participants list, you can send private Chat messages to individuals. Messages can be printed and saved to track session communication.</td>
</tr>
<tr>
<td>Collaboration toolbar</td>
<td>The Collaboration toolbar (at the top of the Content area) contains three buttons for switching between the three content modes (Whiteboard, Application Sharing and Web Tour) in the Content area; an Information menu for obtaining session information (e.g., connection type) and starting the Timer; a Load Content button for loading content into the session; and the Record button.</td>
</tr>
<tr>
<td>Content area</td>
<td>The Content area is the main presentation window. Moderators use this region to load presentations. Everyone can use the tools on the Whiteboard to draw or write. All the objects and images on the Whiteboard are dynamic and can be modified. Everyone can print the Whiteboard pages or save them to a file to review later (unless the Whiteboard has been protected).</td>
</tr>
</tbody>
</table>
This chapter describes the Blackboard Collaborate menus and Content area modes, and discusses how to exit the session. The Audio & Video, Participants, Chat and Audio, panels and the three content modes (the Whiteboard, Application Sharing and Web Tour) are described in detail in their respective chapters.
The Content Area Modes

The content area on the right side of your Blackboard Collaborate web conferencing interface, enables you to exchange information and ideas with others through three different features:

- the Whiteboard, for sharing presentations and drawings;
- Application Sharing, for sharing individual applications or your entire desktop; and
- Web Tour, for sharing web pages.

These features share space in the content area, with each representing a "mode" in the content area, so you will be able to see the content of only one mode at a time. The Whiteboard content is persistent so will be there when you move to another mode and then return to the Whiteboard. Application Sharing content is persistent but you need to Resume Sharing when you return to Application Sharing in order to see it. Web Tour content will always have to be reloaded (URL entered again) when you switch modes and return to Web Tour.

Only certain users can switch between modes:

- Moderators can switch between all modes.
- Participants with Application Sharing permission can switch to Application Sharing mode and back to Whiteboard mode.
- Participants with Web Tour permission can switch to Web Tour mode and back to Whiteboard mode.

---

**Note:** Participants who have Whiteboard permission but not Application Sharing or Web Tour permission are not able to switch to Whiteboard mode from either of the other two modes. This safeguards against Participants switching modes during someone else's Web Tour or Application Sharing presentation.

---

When someone switches modes, everyone in the session will follow them to the new mode.

---

**Caution:** Be careful not to inadvertently switch modes on someone else who is presenting content. Everyone in the session will follow you to the new mode.
To switch modes, do one of the following:

- Click on the button in the Collaboration toolbar associated with the desired mode.
- Select the desired mode from the View menu.
- Use the keyboard shortcut associated with the desired mode:
  - Whiteboard mode: Ctrl+Alt+W (Command-Option-W on Mac)
  - Application Sharing mode: Ctrl+Alt+A (Command-Option-S on Mac)
  - Web Tour mode: Ctrl+Alt+U (Command-Option-U on Mac)

You can easily see which mode is selected by noting which button in the Collaboration toolbar is colored. In the Collaboration toolbar below, the current mode is Whiteboard mode.

1. Whiteboard mode button
2. Application Sharing mode button
3. Web Tour mode button

The Menus

Most of the functionality of Blackboard Collaborate web conferencing can be accessed through the menus. In addition to selecting menu options with your mouse, you can use mnemonics and, for some functions, keyboard shortcuts.

Menus in the Main Menu Bar

The following menus are available in Blackboard Collaborate in the main menu bar:

- **File menu**: Contains file-related commands (New, Open, Save and Print) for Whiteboard files, Multimedia files, quizzes, session plans, Chat conversations and the Participants list. It is also where you will find the Exit command for closing Blackboard Collaborate web conferencing.
- **Edit menu**: Contains standard editing commands (Cut, Copy, Paste and Select All) and enables you to open the Preferences dialog.
- **View menu**: Contains commands for changing your window layout and changing content modes (Whiteboard, Application Sharing and Web Tour).
- **Tools menu**: Contains sub-menus for using the various tools in Blackboard Collaborate: Application Sharing, Audio, Chat, Interaction, Profile, Video and Whiteboard.
- **Window menu**: Enables you to open the following windows: Activity, Graphing Calculator, Notes and File Transfer Library.

- **Help menu**: Gives you access to documentation (a table of Keyboard Shortcuts, the Accessibility Guide, the Blackboard Collaborate Essentials Guide and the On-Demand Learning Center web site), provides diagnostic tools (that Support personnel may ask you to use to help troubleshoot an issue), enables you to leave the session without closing the application (and then rejoin it) and provides general information about the Blackboard Collaborate web conferencing software.

**Drop-Down Menus**

In addition to the menus in the main menu bar, Blackboard Collaborate has a number of drop-down menus throughout the interface. Two types of drop-down menus are noteworthy:

- **Options menus**: Most of the main modules in the interface have their own Options menus to give you quick access to commands specific to those modules. (These commands also can be found in the main menus.)

  To open an Options menu, either click on it with your mouse or use the keyboard shortcut Ctrl+Shift+O (Command-Shift-O on Mac).

  **Tip**: The keyboard shortcut will open the Options menu of whichever module currently has keyboard focus. Be sure to move focus to the desired module before using the keyboard shortcut.

- **Participant interaction menus**: There are two drop-down menus in the Participants panel that enable you to enter your feedback and responses in the Participants list: the Feedback menu containing emoticons (see *Entering Feedback* on page 30) and the Polling Response menu (see *Polling* on page 33). By default, whatever you select from one of these menus will be displayed in the Participants list (next to your name) for everyone to see. (A Moderator may turn off the display of polling responses.)

  **Tip**: You do not need to click on these menus to open them. They will open up automatically when you hover your mouse over them.
Closing the Application

To close the Blackboard Collaborate web conferencing application, do one of the following:

- From the File menu, select Exit (Windows and Linux) or from the Blackboard Collaborate web conferencing menu, select Quit (Mac OS X).
- Click on the window’s Close button.
- Enter Ctrl+Q (Command-Q on Mac)
- Enter Alt+F4 (Windows and Linux only)

By default, a confirmation dialog will prompt you to confirm whether or not you want to leave the session. For instructions on how to hide this dialog in the future, see The Confirmation Dialog.

**Note:** When you leave a session, you may be directed to a web page defined by the session creator. Your default web browser will launch automatically.

The Confirmation Dialog

By default, you will be prompted to confirm whether or not you want to leave the session. Click on OK to leave the session or Cancel to stay in the session.

To turn this confirmation off for future sessions, select the option *Don’t remind me again* and click on OK. You can turn the reminder back on for future session, using the Preferences dialog:

1. Open the Preferences dialog in one of the following ways:
   - From the Edit menu, select Preferences... (Windows & Linux)
   - From the Blackboard Collaborate web conferencing menu, select Preferences (Mac OS X)
   - Enter Ctrl+Comma (Windows & Linux)
   - Enter Command-Comma (Mac OS X)
2. In the left pane of the Preferences dialog, select Leaving under Session. The Session Leaving preferences panel appears.

![Preferences dialog with Leaving panel highlighted](image)

3. Unselect the option *Ask for confirmation before leaving a session*.

4. Click on **OK** to save your preferences and close the Preferences dialog, **Apply** to save your preferences and leave the Preferences dialog open or **Cancel** to close the Preference dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate web conferencing will remember the settings each time you join another session on the same computer.
Chapter 4

Attending Sessions on Mobile Devices

**Important Note:** Do not attempt to moderate a session from a mobile device. **Moderator-only functions (such as loading content and session permissions) are not supported on mobile devices.** Moderators should join the session from a desktop or laptop computer.

**Note:** Accessing and participating in web conferencing sessions on mobile devices is not supported for all user login groups. Contact your Blackboard Collaborate system administrator for details.

The following Blackboard Collaborate web conferencing functionality is supported on mobile devices (mobile phones and tablets):

- use Audio to communicate
- interact with others via the Participants panel
  - use Raised Hand and Stepped Away indicators
  - enter polling responses
  - see who is in your current room (either Main room or Breakout Room)
- enter and read Chat messages
- view Application Sharing
- view Whiteboard
- attend Breakout Rooms

**Note:** For a discussion of attending sessions on mobile devices, refer to the Mobile User's Guide for your device (iOS or Android) on the On-Demand Learning Center:
http://www.blackboard.com/Platforms/Collaborate/Services/On-Demand-Learning-Center/Web-Conferencing.aspx#documentation
Chapter 5

The Participants Panel

The Participants panel provides you with information about yourself and others in the session. You can view the user profiles of others and edit your own, see what features others are currently using and see what permissions you and others have. The Participants panel also gives you tools for interacting with others in the session: you can enter emoticons, raise your hand, indicate that you have stepped away from the session, send a private Chat message and respond to polls conducted by a Moderator.

Note: Not all features of the Participants panel are supported on mobile devices. For a list of features that are supported, see Attending Sessions on Mobile Devices on page 21.
The Participants panel has the following components:

1. Expand/Collapse button
2. Feedback menu
3. Step Away button
4. Raise Hand button
5. Polling Response menu
6. Participants list
7. Global options menu
8. Status area
9. Toolbar
10. Activity indicators
11. Participant options menu

Your name appears at the top of the Participants panel in the Status area as well as in the Participants list below it. In both places you will see information about your permissions (see Understanding Permissions below), your current activity (see Status Indicators on page 32) and your profile (see Editing Your User Profile on page 36). In the Participants list, all the Moderators in the session are displayed in alphabetical order at the top of the list (above the horizontal rule), followed by all the Participants, who are also listed in alphabetical order.

Understanding Permissions

Your access to Blackboard Collaborate web conferencing features is managed by permissions. Moderators can change your permissions, either by changing the global permissions (those that apply to all Participants) or by changing your permissions only.

For information on how permission information is presented in the Participants panel, see Permission Indicators in the Participants List on page 26.

The following table shows the icons associated with each permission and describes what the permissions entail.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Permissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎤</td>
<td>The Audio permission allows Participants to talk in the session. If the permission is not granted, they can still listen to others.</td>
</tr>
<tr>
<td>📹</td>
<td>The Video permission allows Participants to transmit video in the session. If the permission is not granted, they can still preview their own video and view the video transmissions of others.</td>
</tr>
<tr>
<td>📣</td>
<td>The Chat permission allows Participants to enter chat messages in the session. If the permission is not granted, they can still send private chat messages to Moderators and read the Chat messages of others.</td>
</tr>
<tr>
<td>✒️</td>
<td>The Whiteboard permission allows Participants to use the drawing tools in the Whiteboard. It doesn't allow them to load content (e.g., presentations) into the Whiteboard, which requires Moderator privileges, nor to switch to Whiteboard mode from another mode (see The Content Area Modes on page 16). Neither does it allow them to navigate between pages in the Main room, which requires the Moderator to turn off the Follow option. If the permission is not granted, Participants can still view the Whiteboard content entered by Moderators.</td>
</tr>
<tr>
<td>🎥</td>
<td>The Application Sharing permission allows Participants to host an Application Sharing session, including switching to Application Sharing mode (see The Content Area Modes on page 16) and back to the Whiteboard. It also enables them to request remote control of anyone’s Application Sharing session or the desktop of Moderators or other Participants who also have the Application Sharing permission; in both cases, the request can be denied by the host. If the Application Sharing permission is not granted, Participants can still view others’ shared applications or desktops.</td>
</tr>
<tr>
<td>🎥</td>
<td>The Web Tour permission allows Participants to host Web Tours and Web Pushes, including switching to Web Tour mode (see The Content Area Modes on page 16) and back to the Whiteboard. If the Web Tour permission is not granted, Participants can still view others' Web Tours.</td>
</tr>
<tr>
<td>📢</td>
<td>The Closed-Captioning permission allows Participants to enter text into the Closed-Captioning window. If this permission is not granted, Participants can still read the Closed-Captioning text of others. (Note: this permission can be set only from the Participant option menu – i.e, it cannot be set globally for all Participants.)</td>
</tr>
</tbody>
</table>
Permission Indicators in the Participants List

Only those individual permissions (granted or revoked) that represent exceptions to the global permissions are displayed in the Participants list.

Note: You can view all your permissions – not just the exceptions – in your Participants panel Status Area. See Viewing all of your Permissions on the facing page.

When a Moderator removes your permission to use a globally permitted feature, the icon representing that feature is stamped with a red X and appears next to your name in the Participants list.

In the example below, the global permissions (shown to the right of the room name) are set to the default (permission to use Audio, Video, Chat and Whiteboard but not Application Sharing and Web Tour) and the exceptions to these are indicated by the icons next to the session attendee names in the Participants list.

- The Moderator has granted Charlie the Closed-Captioning permission and revoked his permission to transmit video 🎥.
- Lucy has been granted the Application Sharing permission.
- Ricky has been granted the Web Tour permission and his Audio permission has been revoked: 🎧.
**Viewing all of your Permissions**

If you would like to see a complete list of all your permissions, not just the exceptions to the global permissions, select *Show My Permissions* from the Global Options menu of the Participants panel. Your permissions will be displayed in the Status area at the top of the Participants panel. (Your activity and status indicators are also displayed in the Status area.)

![Image](image.png)

**Note:** All the individual permissions (granted or revoked) that represent exceptions to the global permissions are still displayed in the Participants list.

---

**Knowing When Someone has Joined or Left a Session**

There are five ways to tell when someone has joined or left a session:

- The person’s name will appear in the Participants list when they join the session and will be removed when they leave the session.
- An Audible Notification may be played when someone joins or leaves a session.
- A Visual Notification may be displayed when someone joins a session.
- A message will be displayed in the Chat conversation area.
- A message may be displayed in the Activity Window.
Raising and Lowering Your Hand

Moderators and Participants can raise their hands at any time during the session. The Participants list will indicate who has raised their hand and in what order. When a Participant raises their hand, their name goes to the top of the participant list, just under the Moderators. There are two ways to raise your hand:

- **Participants panel**
  Click the button.

- **Keyboard shortcut**
  Enter Ctrl+R (Command-R on Mac).

There are three ways to lower your hand:

- **Participants panel**
  Click the button.

- **Participant Options menu**
  Select *Lower Hand*.

- **Keyboard Shortcut**
  Enter Ctrl+R (Command-R on Mac).

Raised Hand Notification

Each time someone raises their hand, you may be notified in one or both of the following ways:

- A red hand icon will appear over the profile picture (or avatar) of the person who raised their hand. A number will appear under their name indicating where they are in the queue of those who have raised their hands (the order in which hands were raised).

- An Audible Notification may be played. You can configure your Audible Notification preferences to play one sound when you raise your own hand and another when someone else raises theirs – or you can turn the sound off altogether.
Stepping Away

The Step Away feature enables you to indicate to the others in the session that you are temporarily unavailable. You are still connected to the session and can see and hear everything that is going on – others just won’t expect you to be available for interaction.

There are three ways to show that you have stepped away:

- Click on the button in the Participants panel.
- From the Tools menu, select Interaction and then select Step Away.
- Enter Ctrl+Shift+A (Shift-Command-A on Mac).

The Step Away indicator (clock icon and the word "Away") will appear next to your name in the Participants list for everyone to see. You will also see the indicator next to your name in the Status area (top) of the Participants panel.

Stepping Back

There are three ways to show that you have stepped back into the session:

- Click on the button in the Participants panel.
- From the Tools menu, select Interaction and then unselect Step Away.
- Press Ctrl+Shift+A (Shift-Command-A on Mac).

The Step Away indicator will be removed from the Participants list so others will know you are back in the session.
Entering Feedback

Moderators and Participants can select feedback options from the Feedback menu or via keyboard shortcuts. These options express common reactions to a presentation. An indicator associated with each option appears for a short time to the right of the name of the person who selected it.

There are three ways to select one of the feedback options:

- **Participants panel Feedback menu**
  
  Select the desired option.

- **Interaction Sub-menu of Tools Menu**
  
  From the Tools menu, select Interaction followed by Show Emotion and select the desired option from the submenu. This menu is identical to the menu in the Participants panel.
○ **Keyboard Shortcuts**

Enter the appropriate keyboard shortcut for the desired option.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Emotion</th>
<th>Windows and Linux Keyboard Shortcuts</th>
<th>Mac Keyboard Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>😊</td>
<td>Show Smiley Face</td>
<td>Alt+1</td>
<td>Option-1</td>
</tr>
<tr>
<td>😊😊</td>
<td>Show LOL</td>
<td>Alt+2</td>
<td>Option-2</td>
</tr>
<tr>
<td>🙌</td>
<td>Show Applause</td>
<td>Alt+3</td>
<td>Option-3</td>
</tr>
<tr>
<td>😞</td>
<td>Show Confusion</td>
<td>Alt+4</td>
<td>Option-4</td>
</tr>
<tr>
<td>🙅</td>
<td>Show Approval</td>
<td>Alt+5</td>
<td>Option-5</td>
</tr>
<tr>
<td>🙅♂️</td>
<td>Show Disapproval</td>
<td>Alt+6</td>
<td>Option-6</td>
</tr>
<tr>
<td>⬅️</td>
<td>Show Slower (when you want the presenter to slow down)</td>
<td>Alt+7</td>
<td>Option-7</td>
</tr>
<tr>
<td>➤</td>
<td>Show Faster (when you want the presenter to speed up)</td>
<td>Alt+8</td>
<td>Option-8</td>
</tr>
<tr>
<td>🟢</td>
<td>Show None (clears all displayed feedback icons)</td>
<td>Alt+0</td>
<td>Option-0</td>
</tr>
</tbody>
</table>

**Activity Indicators**

The Participants list presents information about user activity through activity indicators. These indicators display information about what feature a user is currently using, show if a user is using the Audio Setup Wizard or indicate if a user has stepped away from the session.

---

**Note:** Alongside the activity indicators, you may see other icons in the Participants list. There may be permission icons (see *Understanding Permissions* on page 24) or status indicators showing that users are experiencing delays (see *Status Indicators* on next page)

<table>
<thead>
<tr>
<th>Activity Indicator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎤</td>
<td>User has turned on his/her microphone.</td>
</tr>
<tr>
<td>Activity Indicator</td>
<td>Meaning</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------</td>
</tr>
<tr>
<td>🎧</td>
<td>User is running the Audio Setup Wizard.</td>
</tr>
<tr>
<td>📺</td>
<td>User is transmitting Video.</td>
</tr>
<tr>
<td>📣</td>
<td>User is entering a Chat message.</td>
</tr>
<tr>
<td>🖌️</td>
<td>User is entering content into the Whiteboard with one of the Whiteboard drawing tools or, if the user is a Moderator, may be loading content into the Whiteboard.</td>
</tr>
<tr>
<td>🎥</td>
<td>User is hosting an Application Sharing session.</td>
</tr>
<tr>
<td>🎥</td>
<td>User is conducting a Web Tour or Web Push.</td>
</tr>
<tr>
<td>🕒</td>
<td>User has stepped away from the session.</td>
</tr>
</tbody>
</table>

In the example to the right,

- Charlie is entering a Chat message and is also using the Audio Setup Wizard;
- Ethel has the Talk button pressed;
- Lucy is entering Closed-Captioning text;
- Ricky has stepped away from the session; and
- Vivian is transmitting Video.

**Status Indicators**

Status indicators are amber and red lights that appear on the activity indicators in the Participants list when there is a delay in the sending and/or receipt of Audio, Video and Application Sharing data. An amber status indicator denotes a moderate delay whereas a red status indicator denotes a significant delay.

The status indicators are dynamic and are updated and visible throughout the session. By keeping an eye on these indicators, you can see when it might be appropriate to adjust your pace (e.g., temporarily stop talking, turn off your Video camera or pause your Application Sharing session) so others can catch up.
In the example to the right,
- Charlie is talking,
- Ricky is experiencing a moderate delay in receiving Audio,
- Vivian is experiencing a significant delay in receiving Audio, and
- Ethel is not having any problems receiving Audio.

**Note:** For details about the various status indicators, refer to the chapters on Application Sharing, Audio and Video.

### Polling

A Moderator may ask you to participate in an poll. There are four poll types:

- Yes/No Options (the default)
- Multiple-Choice Responses A – C
- Multiple-Choice Responses A – D
- Multiple-Choice Responses A – E

People can respond to questions by selecting response options from the Polling Response menu in the Participants panel or by entering keyboard shortcuts (listed in the following table).

When the Moderator selects a different type of poll, the available response buttons will change accordingly.
<table>
<thead>
<tr>
<th>Type of Poll</th>
<th>Response Buttons</th>
<th>Windows and Linux Shortcuts</th>
<th>Mac Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes/No</td>
<td>✅, ✗</td>
<td>Yes: Ctrl+1</td>
<td>Yes: Command-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>No: Ctrl+2</td>
<td>No: Command-2</td>
</tr>
<tr>
<td>Multiple Choice with three answer choices</td>
<td>a, b, c</td>
<td>A: Ctrl+1</td>
<td>A: Command-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>B: Ctrl+2</td>
<td>B: Command-2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>C: Ctrl+3</td>
<td>C: Command-3</td>
</tr>
<tr>
<td>Multiple Choice with four answer choices</td>
<td>a, b, c, d</td>
<td>A: Ctrl+1</td>
<td>A: Command-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>B: Ctrl+2</td>
<td>B: Command-2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>C: Ctrl+3</td>
<td>C: Command-3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>D: Ctrl+4</td>
<td>D: Command-4</td>
</tr>
<tr>
<td>Multiple Choice with five answer choices</td>
<td>a, b, c, d, e</td>
<td>A: Ctrl+1</td>
<td>A: Command-1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>B: Ctrl+2</td>
<td>B: Command-2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>C: Ctrl+3</td>
<td>C: Command-3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>D: Ctrl+4</td>
<td>D: Command-4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>E: Ctrl+5</td>
<td>E: Command-5</td>
</tr>
<tr>
<td>None (clears all displayed polling responses)</td>
<td>blank square</td>
<td>Ctrl+0</td>
<td>Command-0</td>
</tr>
</tbody>
</table>

Moderators can determine whether polling responses are visible to both Moderators and Participants or Moderators only. For details about viewing the polling results, see Viewing Polling Results below.

**Viewing Polling Results**

If a Moderator has enabled it, Participants can see the responses of others displayed next to their names in the Participants list. Your own response is also shown in the button of the Polling Response menu.
User Profiles

User Profiles are a means for users to publish information about themselves and to view information provided by others.

Viewing a User’s Profile

A user’s profile appears in a floating display beside the Participants list.

To view a user’s profile, hover your mouse over their name in the Participants list. The content displayed in the user’s profile varies depending on how completely the user has filled in his or her profile.

If a user does not have a profile, the display will simply contain the same name that is already listed in the Participants list.
To dismiss the profile, click on it or move your cursor off of the Participants list.

**Editing Your User Profile**
Create or edit your Profile in the Preferences dialog.

---

**Note:** All fields in the My Profile preferences dialog are optional.

1. Open the Preferences dialog in one of the following ways:
   - From the Edit menu, select *Preferences*... (Windows & Linux)
     - From the Blackboard Collaborate web conferencing menu, select *Preferences* (Mac OS X)
   - Enter Ctrl+Comma (Windows & Linux)
     - Enter Command-Comma (Mac OS X)

---

**Tip:** Alternatively, from your Participants Option menu in the Participants list, select *Edit Profile.*
2. (Skip this step if you selected Edit Profile from your Participants Option menu in the Participants list.) In the left pane of the Preferences dialog, select the My Profile preferences panel under Profile.

3. Enter your information in the desired fields under the Identity tab. To insert a photo, click the Change button and browse to select your photo. To remove the photo, click on the Clear button.

   **Tip:** Only .gif and .jpg or .jpeg files can be used for your User Profile photo. If your photo is larger than 96 x 96 pixels, it will be automatically scaled to fit the available space.
4. Click on the Contact tab and enter information in the desired fields.
5. Click on the Addresses tab and enter information in the desired fields.

6. Click on **OK** to save your preferences and close the Preferences dialog, **Apply** to save your preferences and leave the Preferences dialog open or **Cancel** to close the Preference dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate web conferencing will remember the settings each time you join another session on the same computer.

**Importing a vCard file**

Instead of creating a new user profile for a Blackboard Collaboratesession from scratch, you can import an existing vCard (*.vcf file).

1. Open the My Profile preferences dialog box. (See steps 1 and 2 under *Editing Your User Profile*.)

2. Click on the **Import** button. The Open dialog box will open.

3. Navigate to the directory containing your vCard, select the .vcf file you wish to import and then click on **Open**.

4. Click on **OK** to save your new profile and close the Preferences dialog, **Apply** to save your new profile and leave the Preferences dialog open or **Cancel** to close the Preference dialog without saving any of your changes.
Exporting a vCard file

You can export your Blackboard Collaborate profile as a .vcf file and import it into other applications (such as Outlook).

1. Open the My Profile preferences dialog box. (See steps 1 and 2 under Editing Your User Profile.)
2. Click on the Export button. The Save dialog will open.
3. Navigate to the location in which you want to save the *.vcf file and then click on Save.
4. Click on OK to complete the export and close the Preferences dialog, Apply to complete the export and leave the Preferences dialog open or Cancel to close the Preference dialog without completing the export.

Mobile Device Indicators

The Participants list displays indicator icons next to people's names when they are connected to a session using mobile devices: a mobile phone or tablet. This information is important because mobile users are somewhat limited in the Blackboard Collaborate features they can use and you may want to tailor your session activity to accommodate them.

For a list of features supported on mobile devices, see Attending Sessions on Mobile Devices on page 21.

---

**Important Note:** Do not attempt to moderate a session from a mobile device. **Moderator-only functions (such as loading content and session permissions) are not supported on mobile devices.**

Moderators should join the session from a desktop or laptop computer.

---

**Note:** Accessing and participating in web conferencing sessions on mobile devices is not supported for all user login groups. Contact your Blackboard Collaborate system administrator for details.

---

**Note:** No device icon is displayed for users connected to the session using a desktop, laptop or notebook computer.

<table>
<thead>
<tr>
<th>Device Indicator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>📱</td>
<td>User is connected to the session using a mobile phone.</td>
</tr>
<tr>
<td>📱</td>
<td>User is connected to the session using a tablet.</td>
</tr>
</tbody>
</table>
In the following example, Vivian and Charlie are connected to the session using desktop computers, Lucy is connected using a mobile phone and Ethel is connected using a tablet. (Ricky has stepped away from the session.)
Chapter 6

Video

The Video feature of Blackboard Collaborate web conferencing enables you to transmit and receive video broadcasts with others in a session. A video broadcast is video you send live via a video camera (e.g., web cam) – not to be confused with a pre-recorded video (movie) that Moderators can play using the Multimedia feature.

Note: This feature is not supported on mobile devices. For a list of features that are supported, see Attending Sessions on Mobile Devices on page 21.

The Video feature can display up to six simultaneous camera transmissions. For details, see Multiple Simultaneous Cameras on page 51.
The Audio & Video window has the following Video components:

1. Expand/Collapse button
2. Options menu
3. Primary video display
4. Preview Video button
5. Transmit Video button

You will know someone is transmitting video (has their Transmit Video button turned on) when the blue Video activity indicator appears next to their name in the Participants list. (For details on activity indicators, see Video Activity, Permission and Status Indicators below.) In the example below, Vivian and Lisa are transmitting video.

If the Video button is disabled (grayed out) in your Audio & Video panel, it means you do not have permission to use Video. You can always view another's video transmission, change your video display, preview your own Video and set your camera preferences but you need the Video permission in order to transmit. (For information on permissions, see Understanding Permissions on page 24.)

**Video Activity, Permission and Status Indicators**

You can monitor the state of Video activity and permissions through indicators displayed in the Participants list of the Participants panel.

For details about permissions, see Understanding Permissions on page 24.
Activity and Permission Indicators

The following table describes the icons displayed in the Participant list to indicate Moderator and Participant permissions and activity while using Video.

<table>
<thead>
<tr>
<th>Activity Indicator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="user-camera-icon" /></td>
<td>User has turned on his/her video camera.</td>
</tr>
<tr>
<td><img src="image2" alt="video-permission-off" /></td>
<td>Video permission is set globally to &quot;on&quot; but the Moderator has revoked Video permission from this user.</td>
</tr>
<tr>
<td><img src="image3" alt="video-permission-on" /></td>
<td>Video permission is set globally to &quot;off&quot; but the Moderator has granted Video permission to this user.</td>
</tr>
</tbody>
</table>

Status Indicators

Status indicators appear on the Video activity indicator icons of Video users in the Participants list if there are delays in the transmission or receipt of Video. When there are delays, the server begins to drop frames. You will experience delays as a drop in video quality. The degree of delay is indicated by color:

- **Amber Indicator**: Appears when a person's receipt or transmission of video is moderately delayed.
- **Red Indicator**: Appears when a person's receipt or transmission of video is significantly delayed. This may indicate a problem with the network connection and often will be followed by the user getting disconnected from the session.

In the example to the right,

- Vivian is transmitting video,
- Lisa is experiencing a moderate delay in receiving Video,
- Lucy is experiencing a significant delay in receiving Video, and
- Charlie is not having any problems receiving Video.

Previewing and Transmitting Video

Before you transmit video to everyone in the session, it is a good idea to preview it first to check the quality of the image. If it is not satisfactory, you may want to adjust your camera settings (refer to the documentation for your camera).
Tip: If your Video button is inaccessible (grayed out) it may be because a Moderator has removed your Video permission or the maximum number of simultaneous cameras has been reached.

Note: If your Audio & Video panel is in its collapsed state, it will automatically be expanded when you preview or transmit video.

Previewing Video
To preview video, click on the Preview button. Notice that, when activated, your Preview button turns blue. The images captured by your camera will be displayed in your primary video display, along with the word "Preview". No one else will be able to see your preview.

1 Preview image
2 Preview button

Note: If you get an error when you click on the Preview button (such as "Cannot connect to the video source"), your camera may be in use by another application or you don’t have the correct camera selected under Preferences (see Selecting your Video Camera on the facing page).

Transmitting Video
To transmit video to everyone in the room, do one of the following:

- Click on the Transmit Video button in the Audio & Video panel.
- Enter the keyboard shortcut Ctrl+F3 (Command-F3 on Mac).
Notice that, when activated, your Video button displays a red camera.

1 Video button off
2 Video button on

**Stopping Video Transmission**

To stop video transmission, turn your camera off in the same way you turned it on:

- Click on the Video button in the Audio & Video panel.
- Enter the keyboard shortcut Ctrl+F3 (Command-F3 on Mac).
- Click on the Preview button. You will continue to see video images, but others in the session will not.

**Selecting your Video Camera**

If you have only one video camera installed on your computer, that device is automatically used by Blackboard Collaborate web conferencing to preview and transmit video. However, if you have more than one video input device on your computer, you can select which device you want to use through the Preferences dialog.

1. Open the Preferences dialog in one of the following ways:
   - From the Edit menu, select Preferences... (Windows & Linux)
   - From the Blackboard Collaborate web conferencing menu, select Preferences (Mac OS X)
   - Enter Ctrl+Comma (Windows & Linux)
   - Enter Command-Comma (Mac OS X)
2. In the left pane of the Preferences dialog, select Camera Settings under Audio/Video.

![Camera Settings dialog](image)

3. Select the desired camera from the Select the camera to use drop-down list.

4. Click on OK to save your preferences and close the Preferences dialog, Apply to save your preferences and leave the Preferences dialog open or Cancel to close the Preference dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate web conferencing will remember the settings each time you join another session on the same computer.

**Viewing Video**

To view the video being transmitted by others, your primary video display must be open. If it is collapsed, click on the Expand button (in the top left corner of the panel) to open it.
**Tip:** Alternatively, if you want to preview your Video, click on the Preview Video button to expand the panel. If you want to transmit Video, click on the Video button to expand the panel.

If you do not wish to view another's video transmission, collapse the primary video display by clicking on the Collapse button.

**Tip:** When you collapse your primary video display when viewing video, incoming video is not transmitted to you. This will reduce the bandwidth used and will improve the overall responsiveness of Blackboard Collaborate. (If you are transmitting video, collapsing the video display will not affect bandwidth – video will still be transmitted.)

**Note:** For information on working with panels, see the Participant's Guide.

In the primary video display, you may see either someone's profile picture (or default profile icon) or Video transmission. The display will also show their name.

![Primary Video Display Diagram](image)

1. Collapse button
2. Primary Video display
3. Name of transmitter

**The Default Views**

By default, the option *Make Video Follow Speaker* is turned on and the Moderator-only option, *Make Video Follow Moderator Focus*, is turned off. These options affect what is shown in the primary video display. (For information on these options and how to change what is presented in the primary video display, see *Controlling the Primary Video Display* on page 51.)

If the default options are maintained (and you are not previewing your own video), the following happens in the primary video display as people join the session, transmit video or speak:
If you are the first person in the session, your primary video display will be blank. If you click on the Transmit Video button, you will see your own transmission in the primary video display.

When a second person joins the session, you will see their video transmission or, if they are not transmitting video, their profile picture. It is assumed you will want to look at that person, not yourself, regardless of who is speaking. (This happens even if neither of you has spoken.)

As subsequent people transmit video or speak, their video transmissions or profile pictures are added as thumbnails.

**Note:** There is one exception: if neither of the first two parties is transmitting video, when a third person joins the session, the primary video display will go blank until someone transmits video or speaks.

When someone speaks, your primary video display will always show either the profile picture or the video transmission of the person currently speaking or, if no one is speaking, the last person to speak (even if that speaker has left the room).

**Note:** When someone is transmitting video while you are previewing your own video, the received video will be displayed in a thumbnail and the video from your camera will be displayed in your primary video display.

In the example below, Lisa is speaking (she doesn’t have her video camera turned on so you just see her profile picture) and Vivian has her video camera turned on. Vivian’s video is shown in a thumbnail below the primary video display.

**Tip:** Hover your mouse over a thumbnail to display a "tool tip" containing the transmitter’s name.
Multiple Simultaneous Cameras

Sessions can be enhanced by having the video streams of multiple people displayed at once. Blackboard Collaborate web conferencing has the capacity to show the transmissions of up to six video cameras simultaneously. Moderators can disable multiple simultaneous cameras (by setting the maximum allowed to one) or enable from two to six simultaneous cameras.

When there is more than one simultaneous camera enabled, the video stream of one person will appear in the primary video display. Everyone else's transmission will appear below the primary display in thumbnails, up to a maximum of five thumbnails.

For a discussion of what you will see (by default) in the primary video display as more people transmit video, see The Default Views on page 49. For a discussion of how you can change that display, see Controlling the Primary Video Display below.

Controlling the Primary Video Display

The primary video display can be controlled in three ways:

- setting the Make Video Follow Moderator Focus option,
- setting the Make Video Follow Speaker option, and
- by manually selecting what to display.

The Make Video Follow Moderator Focus option is set by Moderators only and overrides an individual's Make Video Follow Speaker option. Both options override a person's ability to manually select what video stream to show in the primary video display.
**Note:** When images change in the primary video display, they may be a bit fuzzy for a few seconds while the server changes the resolution of the new image from low (which is what is used for thumbnails) to a higher resolution (which is used in the primary display).

---

**Make Video Follow Moderator Focus**

Moderators can use the *Make Video Follow Moderator Focus* option to force everyone in the room to see the same thing in their primary video display as what the Moderator is seeing in his or her primary video display. This option overrides all other methods of controlling the primary video display.

**Make Video Follow Speaker**

By default, the option to *Make Video Follow Speaker* is turned on. When it is turned on (and a Moderator has not turned on *Make Video Follow Moderator Focus*), the primary video display will always display either the profile picture or the video transmission (and the name) of the person currently speaking or, if no one is speaking, the last person to speak (even if that person has left the room). The Moderator option *Make Video Follow Moderator Focus* always overrides this option.

If you want to manually select the image to be shown in the primary video display, turn off *Make Video Follow Speaker*. You can do so in two ways (provided the Moderator doesn’t have *Make Video Follow Moderator Focus* turned on):

- From the Tools menu, select Video and then *Make Video Follow Speaker*.
- From the Audio & Video Options menu, select *Make Video Follow Speaker*.

To turn the option back on, just repeat the process.

**Manually Selecting What to Display**

If *Make Video Follow Moderator Focus* and *Make Video Follow Speaker* are turned off, you can manually control what is displayed in your primary video display. To move a thumbnail image into the primary video display, simply click on the thumbnail.

The image that was originally in the primary display will move to the thumbnail in which the moved image previously resided – the images swap places.
Stopping Video Transmission

To stop transmitting video, do one of the following:

- Click on the Video button in the Audio & Video panel.
- Enter the keyboard shortcut Ctrl+F3 (Command-F3 on Mac).
- Click on the Preview button. You will continue to see video images, but others in the session will not.

To stop previewing video, click on the Preview button in the Audio & Video panel.
Chapter 7

Chat

The Chat panel enables you to exchange text messages with others in the session. It has the following components:

1. Expand/Collapse button
2. Message text box
3. Conversation tabs
4. Options menu
5. Conversation pane
6. Emoticon menu
You will know someone is entering a Chat message when the blue Chat activity indicator () appears next to their name in the Participants list. In the example below, Ethel and Lisa are entering Chat messages. (For details about activity indicators, see Chat Activity and Permission Indicators below.)

If the message text box in your Chat panel, says "Send a chat to the Moderator", the menu option Send a Private Chat in a selected person's Option menu is disabled or the Chat permission "off" indicator is displayed next to your name in the Participants list (see Chat Activity and Permission Indicators below), it means you do not have permission to use Chat. You will, however, always be able to read Chat messages and send a message to the Moderators. For instructions, see the Participant's Guide.

Note: For information on working with panels, see the Participant's Guide

### Chat Activity and Permission Indicators

You can monitor the state of Chat activity and permissions through indicators displayed in the Participants list of the Participants panel. These indicators are described in the following table.

For details about permissions, see Understanding Permissions on page 24.

<table>
<thead>
<tr>
<th>Activity Indicator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🗥️</td>
<td>User is typing a Chat message.</td>
</tr>
<tr>
<td>✗</td>
<td>Chat permission is set globally to &quot;on&quot; but Moderator has revoked Chat permission from this user.</td>
</tr>
<tr>
<td>📜</td>
<td>Chat permission is set globally to &quot;off&quot; but Moderator has granted Chat permission to this user.</td>
</tr>
</tbody>
</table>
Viewing Chat Messages

New Chat messages appear at the bottom of the conversation pane of the Chat panel. You can scroll back and forth to read messages in the conversation pane.

When a new message arrives,

- if the scroll thumb is at the bottom of the scroll bar (the last Chat message is visible), the conversation pane will scroll as new messages are received; but
- if you had scrolled back to review earlier messages, the conversation pane will not scroll when new messages are received – you must manually scroll to the bottom to see the new message.

You have the option of turning off event messaging in the Chat conversation pane. For details, see Turning Off Event Messages on next page.
New Messages in Other Conversation Tabs

If you are not in a conversation when a message arrives, you will see a New Message Indicator (Chat bubble) in the tab of that conversation. Simply click on the tab to read your message. (For details on conversation tabs, see Conversation Tabs below.)

Turning Off Event Messages

The Chat conversation pane, by default, gives you event information about who has entered or left the Main room and breakout rooms. If you do not want to view this information, you can turn it off. To do so, unselect Show Event Messages in the Chat Options menu.

Conversation Tabs

When chatting in Blackboard Collaborate, you can participate in more than one Chat conversation at a time. These conversations take place in conversation tabs at the bottom of the Chat panel. When a session begins, there are no conversation tabs.

When a new private conversation is initiated (by you or by someone else with you), a new conversation tab is added to the bottom of the Chat panel for that conversation and a Room conversation tab added for the room you are in (Main room or breakout room).

Note: In some sessions, private chatting between Participants may be disabled. You will always be able to send private Chat messages to Moderators.

Note: Sending and receiving private chat messages is not supported on mobile devices.
As more private chat conversations are initiated, more tabs are opened. When you run out of space for more tabs, new conversation tabs are added to a list on the right side of the Chat panel. Just click on the double arrow icon to open the list of hidden conversation tabs.

1. Click to read new messages
2. Click to open hidden tabs

Note that, when there is a new Chat message in a conversation (one in which you are currently not participating), a New Message Indicator (Chat bubble) is displayed in its tab. In the example above, there is a new message in the conversation with Lucy.

**Moving Between Conversations**

You can move freely between conversations simply by clicking on the conversation tabs or, for private conversations, double-clicking on the name of the person with whom you are conversing. You will be able to catch up on all the messages others entered while you were away.

**Closing Conversation Tabs**

To close a conversation tab, hover your mouse over the people/person icon in the tab until it changes to an X. Click on the X to close the conversation tab.

**Sending Chat Messages**

With Chat, you can send the following types of messages:

- **public** messages to everyone in your current room (Main room or breakout room). For details, see *Sending Messages to Everyone in a Room or Existing Group Conversation* on next page
- **private** messages to one or more selected individuals. This will initiate a new conversation in its own tab. For details, see *Sending Messages to Selected Individuals* on next page

**Note:** Sending and receiving private chat messages is not supported on mobile devices.
Sending Messages to Everyone in a Room or Existing Group Conversation

1. If the desired room tab or existing group conversation tab is not in focus, move to it. (For details, see Moving Between Conversations on previous page.) Go directly to step 3 since your cursor will already be in the message text field.

   **Note:** To start a new group conversation, see Sending Messages to Selected Individuals below.

2. If it isn’t already there, place your cursor in the message text field by doing one of the following:
   - Click anywhere in the message text field.
   - Press Ctrl+M (Command-M on Mac).

3. Enter your text in the message text field. (You can type it or copy and paste from an external source.)

4. Press Enter to send your message. The message will appear in the conversation pane.

Sending Messages to Selected Individuals

You can send private Chat messages to a specific person or group of people by selecting their names in the Participants list. These messages will appear to only yourself and those you selected from the Participants list. There is one notable exception: when a session is supervised, Moderators will be able to see the private messages of everyone.

   **Note:** In some sessions, private chatting between Participants may be disabled. You will always be able to send private Chat messages to Moderators.

   **Note:** Sending and receiving private chat messages is not supported on mobile devices.

A note on Supervised sessions: Some sessions are supervised, meaning that Moderators will be able to see the activity of everyone in the session. You will know a session is supervised by the presence of the word "Supervised" in the title of the Chat panel.

When you are entering a "private" message, keep in mind that all Moderators can read it in supervised sessions.
1. Initiate the message in one of the following ways:
   ○ (If sending to one person) Double-click on the name of the person in the Participants list.
   ○ (If sending to one person) Select the person’s name in the Participants list and then select Send a Private Chat from their Participant Option menu.
   ○ (If sending to multiple people) Select the names of the people in the Participants list (using the standard Shift or Control methods), right-click (Control-click on Mac) on the highlighted names to open the Participants Option menu and then select Send a Private Chat.

   **Tip:** Do not click on the Participant Option menu of any individual – that will unselect all the others you’ve selected in the Participants list.

2. Enter your text in the message text field. (You can type it or copy and paste from an external source.)

3. Press Enter to send your message.
   A new conversation tab will open in your Chat panel and the recipient's Chat panel. The recipient will see a New Message Indicator (Chat bubble) in the tab and will need to click on the new tab to read your message.

**Adding Emoticons to your Chat Message**

Emoticons are special graphical icons that you can insert into any text-based chat to make your conversations more expressive and fun.

You can add emoticons to your Chat messages by selecting them from the Chat Emoticon menu or by entering text strings in the Chat message text field. The text string equivalent of the emoticon selected in the Emoticon menu is displayed in the bottom left corner of the menu.
**Note:** If you do not see the Chat Emoticon menu, it means a Moderator has disabled Chat emoticons. You can still type the text string equivalents of emoticons in the message text box but they won’t be converted to icons. For example, when you type ;), others in the session will see ;-) rather than 😊.

The following table lists a few of the most popular emoticons and their respective text strings. (A full list of the text strings used for entering emoticons is available in the *Participant's Guide*.)

**Note:** The emoticon text strings are not case sensitive, so you can use either upper case or lower case letters to enter your emoticons.

<table>
<thead>
<tr>
<th>Emotions</th>
<th>Icons</th>
<th>Text strings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smiley</td>
<td>:)</td>
<td>:) or :-)</td>
</tr>
<tr>
<td>Wink</td>
<td>;)</td>
<td>;) or ;-)</td>
</tr>
<tr>
<td>Sad</td>
<td>:(</td>
<td>:( or :-(</td>
</tr>
<tr>
<td>Surprised</td>
<td>:-o</td>
<td>:-o or :-O</td>
</tr>
<tr>
<td>Confused</td>
<td>:/</td>
<td>:/ or :/-</td>
</tr>
<tr>
<td>Grin</td>
<td>:D</td>
<td>:D or :-D</td>
</tr>
<tr>
<td>Angry</td>
<td>@</td>
<td>@ or :-@</td>
</tr>
<tr>
<td>Thumbs up</td>
<td>(y)</td>
<td>(y)</td>
</tr>
<tr>
<td>Thumbs down</td>
<td>(n)</td>
<td>(n)</td>
</tr>
</tbody>
</table>

**Adding External Links to your Chat Message**

You can include HTTP links in your Chat messages either by typing them in directly, copying and pasting them or dragging and dropping them from a browser or email message. Recipients of your messages will be able to click on the links to open web sites in their default browsers.

<table>
<thead>
<tr>
<th>Link Type</th>
<th>Syntax</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTP web site</td>
<td>http://</td>
<td><a href="http://www.blackboard.com">http://www.blackboard.com</a></td>
</tr>
</tbody>
</table>
Chapter 8

Audio

The Audio feature enables you to participate in conversations during a Blackboard Collaborate web conferencing session using a microphone and speakers (or headset) via Voice over Internet Protocol (VoIP). If your organization offers teleconferencing services with Blackboard Collaborate, you can use the Telephony (telephone conferencing integration) feature for your in-session communications.

Note: Mobile device users cannot use a teleconference for Audio communications in a session. For a list of features supported on mobile devices, see Attending Sessions on Mobile Devices on page 21.

Audio shares a panel with Video in the Blackboard Collaborate interface. The panel has the following components relevant to Audio:
1 Expand/Collapse button      5 Options menu
2 Microphone Level indicator and slider  6 Primary video display
3 Talk button                    7 Speaker Level indicator and slider
4 Audio Setup Wizard button

You will know someone has their microphone turned on (has activated the Talk button) when the blue Audio activity indicator (📢) appears next to their name in the Participants list. (For details on activity indicators, see Audio Activity, Permission and Status Indicators on page 65.) In the example below, Vivian and Lisa have their microphones turned on.

You may see the Video transmission or the profile picture (or default profile icon) of the person currently speaking in the primary Video display. The display will also show their name. Whether or not you see this depends on the configuration of the Video display. For details, see Viewing Video on page 48.

**Note:** For information on working with panels, see the Participant’s Guide.

If the Talk button is disabled (grayed out) in your Audio & Video panel, it means you do not have permission to use Audio. You can always receive audio and adjust your microphone and speaker levels, but you need the Audio permission in order to send audio. (For information on permissions, see Understanding Permissions on page 24.)
Audio Activity, Permission and Status Indicators

You can monitor the state of Audio activity and permissions through indicators displayed in the Participants list of the Participants panel.

Activity and Permission Indicators

The following table describes the icons displayed in the Participant list to indicate Moderator and Participant permissions and activity while using Audio.

For details about permissions, see Understanding Permissions on page 24.

<table>
<thead>
<tr>
<th>Activity Indicator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎤</td>
<td>User has turned on his/her microphone.</td>
</tr>
<tr>
<td>🎤️</td>
<td>Audio permission is set globally to &quot;on&quot; but the Moderator has revoked Audio permission from this user.</td>
</tr>
<tr>
<td>🎤️️</td>
<td>Audio permission is set globally to &quot;off&quot; but the Moderator has granted Audio permission to this user.</td>
</tr>
<tr>
<td>🎤️️️</td>
<td>User is running the Audio Setup Wizard.</td>
</tr>
</tbody>
</table>

Status Indicators

Status indicators appear on the Audio activity indicator icons of Audio users in the Participants list if there are delays in the receipt of Audio or if the talker or listener is not responding to the Audio service.

- **Amber Indicator**: Appears when a listener's receipt of audio is delayed.
- **Red Indicator**: Appears when a talker or listener is experiencing a significant delay (is non-responsive) and may be offline from the session. This may indicate a problem with the network connection and often will be followed by the user getting disconnected from the session.

In the example to the right,

- Charlie is talking,
- Ricky is experiencing a moderate delay in receiving Audio,
- Vivian is experiencing a significant delay in receiving Audio, and
- Ethel is not having any problems receiving Audio.
Basic Audio Configuration

Generally speaking, it is recommended that you configure your Audio before the session begins. There are a number of Audio settings that you can configure but you will likely only need to set your microphone and speaker levels (see Using the Audio Setup Wizard on page 66). The other available configuration items are advanced and, in most cases, you probably won’t need to modify them. However, if you wish to modify the advanced Audio settings, you can do so in the Preferences dialog.

Using the Audio Setup Wizard

The Audio Setup Wizard is a tool you can use to verify that your Audio is set up correctly. It is comprised of a series of panels that guide you through selecting Audio input (microphone) and output (speaker) devices and setting your speaker and microphone volumes. **We encourage everyone to run the wizard prior to the start of the session.**

**Tip:** To run the Audio Setup Wizard before your session begins, either join your session early or open the Configuration Room on the Blackboard Collaborate Support Portal: [http://support.blackboardcollaborate.com](http://support.blackboardcollaborate.com)

To open the Configuration Room, browse to First Time Users and then to Step 2 under Blackboard Collaborate Web Conferencing.

You can run the Audio Setup Wizard again at any time within your session.

**Note:** When you are using the Audio Setup Wizard during a session, you will not be able to hear any of the session Audio. Others will know you can’t hear them because the Audio Setup Wizard icon 🎧 will appear next to your name in the Participants list.

To open the Audio Setup Wizard, do one of the following:

- Click on the Audio Setup Wizard button at the top of the Audio & Video panel.
- From the Tools menu select Audio and then Audio Setup Wizard.
- From the Audio & Video Options menu, select Audio Setup Wizard.

On Windows or Linux

1. Select your audio output device (speakers), following the instructions given in the dialog box.
2. Play the recorded audio message provided and adjust your speaker volume to a suitable level. (Follow the instructions given in the dialog box.)

3. Confirm whether or not your speaker was set to an appropriate level.
   - If you clicked on Yes, go to step 4.
   - If you clicked on No, you are prompted to try again or cancel. Click on Try Again to go back to step 1.

4. Select an audio input device (microphone), following the instructions given in the dialog box.

5. (Linux only) Select your microphone type to get the best results when testing your microphone.
   - Single Talker: Select this option if using a headset or a microphone just for yourself.
   - Multiple Talkers: Select this option if using a single microphone to pick up multiple talkers, such as when you are in meeting room sharing the microphone with others. This is the default.

6. Press Record and adjust your microphone recording level as you speak into the microphone (audio input device). (Follow the instructions given in the dialog box.) Press Stop when you are done.

7. Press Play to listen to the recording you just made and, based on the loudness and clarity of the recording, determine if your microphone was set to an appropriate level.

8. Confirm whether or not your microphone was set to an appropriate level.
   - If you clicked on Yes, go to step 8.
   - If you clicked on No, you are prompted to try again or cancel. Click on Try Again to go back to step 4.

9. Read the message in the dialog box and click on OK to complete Audio setup and exit the Audio Setup Wizard.

**On Mac OS X**

1. Mac users cannot change their audio output (speaker) devices directly in Blackboard Collaborate web conferencing – Blackboard Collaborate uses the system default device. To change your output device, click on the speaker icon in the Select Audio Output Device dialog of the Audio Setup Wizard and make your changes in the System Preferences Sound Output panel. When done, click on OK to advance to the next panel of the wizard.

2. Play the recorded audio message provided and adjust your speaker (audio output device) volume to a suitable level. (Follow the instructions given in the dialog box.)
3. Confirm whether or not your speaker was set to an appropriate level.
   - If you clicked on **Yes**, go to the next step.
   - If you clicked on **No**, you are prompted to try again or cancel. Click on **Try Again** to go back to step 1.

4. Select an audio input (microphone) device from the list or select the option *Use System Default Device*. Follow the instructions given in the dialog box.

5. (Mac OS X 10.5 and earlier only) Select your microphone type to get the best results when testing your microphone.
   - **Single Talker**: Select this option if using a headset or a microphone just for yourself.
   - **Multiple Talkers**: Select this option if using a single microphone to pick up multiple talkers, such as when you are in a meeting room sharing the microphone with others. This is the default.

6. Press **Record** and adjust your microphone recording level as you speak into the microphone (audio input device). (Follow the instructions given in the dialog box.) Press **Stop** when you are done.

7. Press **Play** to listen to the recording you just made and, based on the loudness and clarity of the recording, determine if your microphone was set to an appropriate level.

8. Confirm whether or not your microphone was set to an appropriate level.
   - If you clicked on **Yes**, go to the next step.
   - If you clicked on **No**, you are prompted to try again or cancel. Click on **Try Again** to go back to step 3.

9. Read the message in the dialog box and click on **OK** to complete Audio setup and exit the Audio Setup Wizard.

### Using Your Microphone

You can turn on your microphone in one of two ways:

- Click on the Talk button in the Audio & Video panel.
- Enter the keyboard shortcut Ctrl+F2 (Command-F2 on Mac).
To turn your microphone off, again click on the Talk button or use the keyboard shortcut. Notice that, when off, your Talk button contains the word Talk only but, when activated, also displays a blue microphone.

1 Talk button off
2 Talk button on

Tip: If your Talk button is inaccessible (grayed out) it may be because a Moderator has removed your Audio permission, the maximum number of simultaneous talkers has been reached or you are using the Telephony feature for audio communications.

Adjusting Microphone and Speaker Levels

The microphone level indicator (microphone icon) shows the volume levels when you are speaking and the speaker level indicator (speaker icon) shows the volume levels when someone else is speaking.

Tip: If all talkers have their microphones set properly, listeners won’t need to keep adjusting their speakers to accommodate changes in volume. The best way to ensure proper microphone and speaker levels is to run the Audio Setup Wizard at the beginning of the session. See Using the Audio Setup Wizard on page 66.

Microphone Level

There are four ways to adjust your microphone level:

- **Audio & Video panel:** Grab the microphone level slider in the Audio & Video panel and drag it to the right to increase the volume and to the left to decrease the volume.

- **Options menu:** From Audio & Video Options menu, select either Adjust Microphone Level Up (to increase the volume) or Adjust Microphone Level Down (to decrease the volume).

- **Tools menu:** From the Tools menu, select Audio and then select either Adjust Microphone Level Up (to increase the volume) or Adjust Microphone Level Down (to decrease the volume).
○ **Keyboard Shortcuts:** Enter Ctrl+Shift+Up Arrow (Shift-Command-Up Arrow on Mac) to increase the volume or Ctrl+Shift+Down Arrow (Shift-Command-Down Arrow on Mac) to decrease the volume.

**Speaker Level**

There are four ways to adjust your speaker level:

○ **Audio & Video panel:** Grab the speaker level slider in the Audio & Video panel and drag it to the right to increase the volume and to the left to decrease the volume.

○ **Options menu:** From Audio & Video Options menu, select either *Adjust Speaker Level Up* (to increase the volume) or *Adjust Speaker Level Down* (to decrease the volume).

○ **Tools menu:** From the Tools menu, select *Audio* and then select either *Adjust Speaker Level Up* (to increase the volume) or *Adjust Microphone Speaker Down* (to decrease the volume).

○ **Keyboard Shortcuts:** Enter Ctrl+Up Arrow (Command-Up Arrow on Mac) to increase the volume or Ctrl+Down Arrow (Command-Down Arrow on Mac) to decrease the volume.
Chapter 9

The Whiteboard

The Whiteboard is the most commonly used (and default) mode of the Blackboard Collaborate web conferencing Content area. It is used for giving presentations (e.g., PowerPoint slides) and for collaboration between session attendees, who can interact by displaying images, writing, or drawing.

If you have permission to use the Whiteboard drawing tools, the Tools palette appears in the Whiteboard Content area.

Note: Mobile device users can only view the Whiteboard, not add content or navigate through its pages. For a list of features that are supported, see Attending Sessions on Mobile Devices on page 21.
The Whiteboard has the following components:

1. Whiteboard Action bar
2. Collaboration toolbar
3. Web Tour Mode button
4. Scaling menu
5. Page name
6. Information menu
7. Whiteboard Page
8. Properties Editor palette
9. Tools palette

When someone is loading content into the Whiteboard or using the Whiteboard tools, the blue Whiteboard activity indicator (🔗) appears next to their name in the Participants list. In the example below, the Moderator Vivian is loading a presentation into the Whiteboard. (For details on activity indicators, see *Whiteboard Activity and Permission Indicators* on the facing page.)
Whiteboard Activity and Permission Indicators

You can monitor the state of Whiteboard activity and permissions through indicators displayed in the Participants list of the Participants panel.

The following table describes the icons displayed in the Participant list to indicate Moderator and Participant permissions and activity while using the Whiteboard.

<table>
<thead>
<tr>
<th>Activity Indicator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>✏️</td>
<td>User is loading content into the Whiteboard or using the Whiteboard tools.</td>
</tr>
<tr>
<td>✗</td>
<td>Whiteboard permission is set globally to &quot;on&quot; but the Moderator has revoked Whiteboard permission from this user.</td>
</tr>
<tr>
<td>✗</td>
<td>Whiteboard permission is set globally to &quot;off&quot; but the Moderator has granted Whiteboard permission to this user.</td>
</tr>
</tbody>
</table>

Adding Content to the Whiteboard

A number of different kinds of content can be added to the Whiteboard. Everyone in the session can add objects using the Tools Palette (see The Tools Palette on page 73) and Moderators can load image, PowerPoint, OpenOffice and Whiteboard files.

The Tools Palette

The Tools palette contains drawing and text tools you can use to create and manipulate objects in the Whiteboard workspace. It also has a pointer tool, a tool to place screen captures on the Whiteboard and a clip art tool to add images from available clip art libraries.

Tools in the palette with a tabbed lower right corner have additional optional tools that can be swapped into their spot. Click and hold or double-click (depending on your operating system) the tool to expand the options.

Participants have access to the Whiteboard tools if they have been granted the Whiteboard tools permission (see Understanding Permissions).
The Properties Editor

When you click on any of the text or drawing tools in the Whiteboard's Tools palette, the Properties Editor palette will appear at the bottom of the Whiteboard. From here you can format your text or graphic by specifying various properties. The contents of the Properties Editor palette changes depending on which tool is being used or which objects are selected. For example, if you are using the Filled Ellipse or Filled Rectangle tool, the Properties Editor will present color buttons only.

The Properties Editor for the Simple Text and Text Editor tools contains buttons to set color, font, size and style properties.

Note: If you select two (or more) different kinds of objects, the Properties Editor palette will display only those attributes common to all of the objects.

Tip: When selecting the color of an object through the Properties Editor, click outside the color palette once to close the palette and then click a second time to start drawing.
**Inserting Text**

The Whiteboard has two text tools. The Simple Text tool creates text as an object directly on the canvas. The text can be manipulated just like a shape or image in a graphic design program. The Text Editor tool creates a bounding box for text, and the text inside can be edited as in a word processor or publishing program.

**Using the Simple Text Tool**

Follow the steps below to enter a single line of text:

1. Click on the Simple Text tool.
   - If the Simple Text tool is not in the Tools Palette, click and hold the Text Editor tool until it expands to reveal the Simple Text tool icon, then click on the Simple Text tool.
2. Select the font name, color, size, bold, underline and/or italics from the Properties Editor.
3. Click the Whiteboard to place an insertion point, and then type the text.
4. Press Enter when you are done typing the line of text.

**Note:** The Simple Text Tool lets you type only one line of text at a time. You cannot insert a line break and the text does not automatically wrap to the next line when it reaches the edge of the Whiteboard page, as the Text Editor does.

**Using the Text Editor Tool**

Follow the steps below to enter multiple lines of wrapping text:

1. Click on the Text Editor tool.
   - If the Text Editor tool is not in the Tools Palette, click and hold the Simple Text tool until it expands to reveal the Text Editor tool icon, then click on the Text Editor tool.
2. Single-click on the Whiteboard to create a text box of the default size (250 x 70 pixels). Alternatively, click and hold down the mouse button as you drag the cursor to create a text box of the desired size. Either way, the Properties Editor will appear at the bottom of the Whiteboard.
3. Select the font name, color, size, bold, underline and/or italics from the Properties Editor.
4. Type your text, pressing Enter when you want to create a new line of text within the text box.
Note: If the amount of text you type exceeds the space available in the text box, a scroll bar will appear on the right side of the text box. If you don’t want the scroll bar, resize the text box to display all the text.

Note: The maximum number of characters that can be entered in a Text Editor object is 10,000.

Inserting External Links

You can insert links into Whiteboard text using either the Simple Text tool or the Text Editor tool. Anyone viewing your Whiteboard page will be able to click on your links to access an Internet site or send an email.

Note: To enter a link using the Simple Text tool, do not enter any text except that contained in the link. If you do, the link will not work.

<table>
<thead>
<tr>
<th>Link Type</th>
<th>Syntax</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTP web site</td>
<td>http://</td>
<td><a href="http://www.blackboardcollaborate.com">http://www.blackboardcollaborate.com</a></td>
</tr>
<tr>
<td>Email message</td>
<td>mailto:</td>
<td><a href="mailto:docs@blackboard.com">mailto:docs@blackboard.com</a></td>
</tr>
</tbody>
</table>

Note: To launch a link, pass over the link with the Selection tool. The pointer will change to a hand. Single click on the link with the hand pointer. The application that opens the link will be specific to your system.

Inserting Special Symbols and Characters (Windows only)

To type a special symbol or character on the Whiteboard, locate the ANSI numeric code for the special symbols or character that you want to type (for a list of all available codes, see the Participant's Guide) and follow these steps:

1. Select the Simple Text tool or Text Editor and click on the Whiteboard where you want to insert the symbol or character.
2. Make sure NUM LOCK is on.
3. Hold down the Alt key and then, using the numeric keypad, type the numeric character code for the character that you want to type. For example, to place the copyright symbol on the Whiteboard hold down the Alt key and enter the numeric character code 0169.

**Note:** Some special characters only can be typed using **Bold** text. If the character you want does not appear when you enter the character code, select the character you typed and choose **Bold** from the Properties Editor.

### Inserting Graphics

Use the following tools to insert graphics into the Whiteboard.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Freehand" /></td>
<td>Select the color, transparency, and line thickness from the Properties Editor.</td>
</tr>
<tr>
<td><img src="image" alt="Line" /></td>
<td>Select the color, transparency, and line thickness from the Properties Editor.</td>
</tr>
<tr>
<td><img src="image" alt="Filled Shapes" /> (rectangle and ellipse)</td>
<td>Select the color and transparency from the Properties Editor.</td>
</tr>
<tr>
<td><img src="image" alt="Empty Shapes" /> (rectangle and ellipse)</td>
<td>Select the color, transparency, and line thickness from the Properties Editor.</td>
</tr>
</tbody>
</table>

**Tip:** Holding down the Shift key while drawing the line will result in a horizontal, vertical or a line at a 45 degree angle depending on the direction that you draw it. Holding down the Shift key while drawing an ellipse will result in a circle. Holding down the Shift key while drawing a rectangle will result in a square.
**Tip:** When selecting the color of an object through the Properties Editor, click outside the color palette once to close the palette and then click a second time to start drawing.

**Inserting Clip Art Images**

Clip art images can be loaded from a Clip Art library of presentation and mathematical symbols. Follow the steps below to insert a clip art image on the Whiteboard:

1. Click on the **Insert Clip Art** button. The Clip Art dialog opens.

2. Select the tab that contains the clip art you wish to load.

3. Select (single-click on) the desired image.

**Tip:** As you hover your mouse over an image, a tool tip will provide a description of the image.

4. Move your cursor to the desired position on the Whiteboard then click on the Whiteboard to anchor the image into position.

**Inserting a Clip Art Background Image**

Follow steps 1 to 3 above to add a background to your Whiteboard page from the Clip Art library. The selected image will be inserted in the background of the Whiteboard page so cannot be edited or moved.

**Tip:** To remove the Clip Art background image, use the same process to select the blank white background image (on the far right).
Inserting Clip Art Images as Stamps

You can use clip art images as stamps, so you can repeatedly insert the same image over and over. To do so, double-click on the desired image in the Clip Art dialog. Your cursor will change to a stamp icon. Click on the Whiteboard in as may places as you want to leave a stamp. The cursor will remain a stamp tool until you select a different clip art image or use one of the Whiteboard drawing tools.

Inserting Screen Captures

The Screen Capture tool creates an image of a portion of your desktop, any application, or web site and loads it into the Whiteboard.

---

Note: You cannot take a screen capture of the Blackboard Collaborate application.

Follow the steps below to capture a screen image:

1. Click on the **Insert Screen Capture** button. A transparent frame appears with four buttons in the middle.

2. Click inside the frame and drag it into position on the screen so that the desired area is completely enclosed by it. Click and drag the edges of the frame to resize it.

   Switching between programs or performing certain other tasks under the frame may cause the frame to stop updating. Click **Refresh** to manually update the frame if this occurs.
3. Do one of the following:
   - Select the option **OK** to capture exactly what is enclosed in the frame at that moment.
   - Select **With Delay** to add a ten second delay before the frame is captured. This gives some time to position the cursor or other feature of the desktop that must be maintained with the mouse in order to be captured.
   - Select **Cancel** to close the frame without capturing an image.

4. The image appears on the Whiteboard. Position the image on the Whiteboard by dragging it to a new location and click on the Whiteboard region to anchor it in position.

### Pointing to Things on the Whiteboard

When you want to draw people's attention to something on the Whiteboard, you can point to it using one of the Pointer tools.

1. Click and hold the ☀️ Pointer tool in the Whiteboard Tools palette until it expands to reveal all available pointers.

![Pointer tools]

2. Click on the desired pointer and, so others will see it as you move it around the Whiteboard, do one of the following:
   - Hold down the left or right mouse button as you move the pointer. Release the mouse button to stamp the pointer image on the Whiteboard.
   - To get the pointer to follow the mouse motion without having to hold down the mouse button, double-click anywhere on the Whiteboard and then move the pointer. To release this mode, click with the mouse again or select a different tool.

---

**Note:** If you don’t do one of the above, the pointer will be visible to only you.

---

### Setting Whiteboard Preferences

The Whiteboard Content Options preferences panel is used to set content loading options and Whiteboard page size. To set the options, do the following:

1. Open the Preferences dialog in one of the following ways:
   - From the *Edit* menu, select **Preferences...** (Windows & Linux)
From the Blackboard Collaborate web conferencing menu, select *Preferences* (Mac OS X)

- Enter Ctrl+Comma (Windows & Linux)
- Enter Command-Comma (Mac OS X)

2. In the left pane of the Preferences dialog, select the *Content Options* preferences panel under *Whiteboard*. This opens the Whiteboard Content Options preferences panel.

3. Set the following options as needed:

   - **Page Insertion Location**: Select where you want newly loaded Whiteboard content to be placed in relation to existing pages: after the current page, before the current page or replace the current page.

   **Tip**: Before you load content into the Whiteboard, remember to move to the appropriate "current" page.
- **Page Size**: You can size your pages for a specific monitor resolution or you can specify the width and height in pixels.
  - If you select Monitor Resolution, use the drop-down menu to choose the appropriate resolution from the list. The default screen resolution is 1280 x 1024 pixels.
  - If you select Canvas Size, enter the Width and Height in the text boxes provided.

Each of the Monitor Resolution options has a corresponding Canvas Size – they are just two ways of expressing the same thing. These options can be used interchangeably.

- **Presentation Import Options**: When selected, the Include Speaker Notes option will place the presenter notes from your imported PowerPoint or OpenOffice.org presentation into the Notes editor of all session attendees.

- **OpenOffice.org Application**: The OpenOffice.org executable will be found automatically on Mac and Windows systems if you select the option Use default OpenOffice.org installation (this is the default). If you wish to use an installation other than the default, unselect Use default OpenOffice.org installation and browse to the location of that installation.

4. Click on **OK** to save your preferences and close the Preferences dialog, **Apply** to save your preferences and leave the Preferences dialog open or **Cancel** to close the Preference dialog without saving any of your changes.

When you configure preferences, Blackboard Collaborate web conferencing will remember the settings each time you join another session on the same computer.

### Working with Whiteboard Pages

As a Participant with the Whiteboard permission, you can work freely in your private work area (create new pages, load content, etc.) but have limited page management capabilities in the main public area (Main Room). You can print the entire Whiteboard or save it to be viewed later, as long as the Whiteboard is not protected.

### Whiteboard Rooms and Groups

The Whiteboard consists of various areas that are visible in the Page Explorer. By default, you will see the Main room and your own private work area.

---

**Note:** You can open the Page Explorer only if you have been granted the page navigation permission by the Moderator.
1. Breakout Rooms
2. Main Room
3. Page Groups
4. Private Work Area

The Main Room

When you first join a session, it will have one blank Whiteboard page in the Main Room. This work area is public and available to all session attendees.

Note: One blank page is the default, however, there may be more pages if the session was configured with a pre-loaded Whiteboard presentation.

Private Work Area

Each session attendee has their own private work area (Work Area <User Name>) with one blank page. No one else in the session, including Moderators, can view another's private work area.

Participants can use their own private work areas only when they have been granted the page navigation permission by the Moderator.
Page Groups

Moderators can organize pages into distinct topics or presentations by creating page groups. Page groups can be inside or outside of a room and can be nested within other page groups.

Breakout Rooms

When a Moderator creates a new breakout room, it is created with one blank Whiteboard page. The breakout room and its pages are accessible to all Moderators and those Participants who have been moved into the breakout room.

Using the Page Explorer

---

Note: You can open the Page Explorer only if you have been granted the page navigation permission by the Moderator.

---

The Page Explorer is a window that lists all your Whiteboard pages and enables you to easily navigate through and manage the pages.

---

Note: Only Moderators can perform page management functions in the Main room and breakout rooms. Participants can manage pages only in their own private work areas. They can, however, copy pages from the Main room or breakout room to their private work areas.

---

To open the Page Explorer, do one of the following:

- Select Show Page Explorer from the Options menu in the Whiteboard Navigation bar in the upper right corner of the Content area.

- Type Ctrl+Shift+P (Command-Shift-P on a Mac).

---

Note: The Page Explorer opens automatically when you load a file into the Whiteboard.

---

Page navigation functions are performed through the Navigation bar at the top of the Page Explorer (see Navigating Between Pages on page 87) and pages can be moved by dragging and dropping them (see Rearranging and Duplicating Pages on page 87). Page management functions are done through the Page Explorer context menu.
You can perform the following functions (as well as others) using the context menu:

**Note:** You can perform only a subset of these page functions outside of your private work area (Work Area <Your Name>).

- Cut, Copy, Paste and Delete pages (see *Cutting, Copying, Pasting and Deleting Pages* on page 90) – private work area only, except for Copy
- Create new pages (see *Creating New Blank Pages* on page 89) – private work area only
- Save the Whiteboard (see *Saving Whiteboard Pages* on page 93)
- Move to the selected page (see *Navigating Between Pages* on page 87) – only if the Moderator has given you the page navigation permission

**Selecting Pages in the Page Explorer**

You can select one or more pages in the Page Explorer. Once you have done so, you can perform operations on the pages by opening the context menu with a right-click (Control-click on a Mac), selecting *Selected Pages* and then selecting the desired function.
Note: You can open the Page Explorer only if you have been granted the page navigation permission by the Moderator.

To select pages, do the following:

- **To select a single page**, click on the page.
- **To select multiple pages**, hold down Control (Command on Mac) as you click on pages, or hold the Shift key to select two pages and all pages between them.
- **To select all of the pages in a room or page group**, right-click (Control-click on a Mac) on a page in the desired room or page group, select Selected Pages from the context menu and then choose Select All Page Peers.

**Viewing Thumbnails**

Moderators can configure pages in the Explorer windows (Page Explorer, Object Explorer and the Select Page(s) dialog) to be displayed as either thumbnails or as icons. When the Moderator configures thumbnails, it changes the display for everyone in the session. Thumbnails are turned on by default.

Note: You cannot turn thumbnails off and on.

The functionality available in Explorer windows (such as copying, pasting, dragging/dropping, etc.) is identical in both views.
Rearranging and Duplicating Pages
Pages can be rearranged and copied using the Page Explorer. Participants can rearrange pages only in their own private work areas. Moderators can rearrange any pages.

Note: You can open the Page Explorer only if you have been granted the page navigation permission by the Moderator.

To move a page, simply select and drag the page(s) to the desired position.
To duplicate a page, hold down the Control key (Option on Mac), click on the page which you want to copy, and drag it to the position where you would like place the duplicate. Release the mouse before releasing the Control key. (If you release Control first, you will end up moving the original page rather than copying it.) A plus (+) symbol overlaying the mouse cursor indicates that the page will be copied instead of moved.

Navigating Between Pages
To navigate between pages, you can use the Whiteboard navigation bar, the Tools menu, the Page Explorer (see Using the Page Explorer on page 84) or the Page Up and Page Down keys on your keyboard.

By default, you need the Moderator's permission to navigate between pages in the Main room or to move to your private work area. By default, in breakout rooms, you can freely navigate between pages but this permission can be turned off by a Moderator. You will know you are free to move between Main room and breakout room pages when you see a red border around your Whiteboard content area.

Note: If the Whiteboard is protected, you will not see the Navigation bar and will not be able to navigate between any pages anywhere.

To move to the next page:
- In the Whiteboard Navigation bar or Page Explorer, click the Next Page button.
- In the Tools menu, select Whiteboard followed by Go to Next Page.
- Enter Alt + Page Down (Option-Page Down on Mac).
- If focus is on the Go to Page menu of the Navigation bar, press the Down Arrow.

To move to the previous page:
- In the Whiteboard Navigation bar or Page Explorer, click the Previous Page button.
- In the Tools menu, select Whiteboard followed by Go to Previous Page.
○ Enter Alt + Page Up (Option-Page Up on Mac).
○ If focus is on the Go to Page menu of the Navigation bar, press the Up Arrow.

- To move to any page that is not adjacent to another, in the Page Explorer, double-click on the desired page or right-click (Control-click on a Mac) on the page and select Go to Page from the context menu.

Using the Whiteboard Navigation Bar

The Whiteboard Navigation bar is a toolbar containing controls that enable you to move between rooms and pages within those rooms. It is located in the upper right corner of the Content area whenever the Page Explorer is not open.

Note: You can use this feature only if you have been granted the page navigation permission by the Moderator.

1 Previous Page button  3 Go to Page menu
2 Next Page button      4 Navigation Options menu

When the Page Explorer is open, the Navigation bar is located at the top of the Page Explorer window.

- Use the Next Page button and Previous Page button to move within the current room or page group. To go to a different room or group, double-click on the page or navigate to it using the Go to Page menu.
- Use the Go to Page menu to select and move to a particular page.
- The Page Counter reflects the position of the current page within its page group. By default, you will not be able to see the Page Counter but the Moderator can turn it on for you.
Creating New Blank Pages

All new Blackboard Collaborate web conferencing sessions contain at least one Main room page and one private work area page for each session attendee. (Additional pages may also have been preloaded by the session creator.) You can add more pages using the New Page button in the Whiteboard Action Bar or in the Create New Pages dialog, where you can set further page options.

**Note:** You can perform this function only in your private work area and you can move to your private work area only if you have been granted the page navigation permission by the Moderator.

To create a single new blank page, click New Page on the Whiteboard Action bar. This creates a single new blank page after the page you are currently on and directly takes you to that page.

To create multiple pages or pages with more options, follow the steps below:

1. Open the Create New Pages dialog in one of the following ways:
   - In the File menu, select New, followed by Whiteboard Page.
   - In the Page Explorer, right-click (Control-click on the Mac) on a page or page group. Select New from the context menu, followed by Whiteboard Page...
   - Enter Ctrl+N (Command-N on the Mac) and select Whiteboard Page in the New dialog.

2. Under Page Location, select a position for the new page(s) relative to the current page.

   **Note:** If the dialog was opened through the Page Explorer, current page refers to the selected page in the Page Explorer rather than the currently viewed page.
3. Under Page Size, select or specify a canvas size. You can size your pages for a specific monitor resolution or you can specify the width and height in pixels.
   - If you select Monitor Resolution, use the drop-down menu to choose the appropriate resolution from the list. The default screen resolution is 1280 x 1024 pixels.
   - If you select Canvas Size, enter the Width and Height in the text boxes provided.
   Each of the Monitor Resolution options has a corresponding Canvas Size – they are just two ways of expressing the same thing. These options can be used interchangeably.

4. Under Page Number and Names, enter a number (up to a maximum of 99) in the Number of new pages text box. Click in the list of pages (below the text box) to see the new ones added. Each page will have a number along with a default Page Name, for example Private Page 2.

5. Optionally, edit the name of each page by double-clicking on the default name in the Page Name column and typing a new name.

6. Click OK. The pages are added sequentially in the position selected in Step 2.

   **Note:** If multiple pages from multiple rooms or page groups were selected in the Page Explorer, pages will be added in the selected position in relation to each of them. For example, if you had two page groups selected and entered 1 for Number of new pages, two pages are created, one in each group. If the Number of new pages was 2, four pages would be created, etc.

---

**Cutting, Copying, Pasting and Deleting Pages**

You can cut, copy, paste, and delete pages from the Whiteboard. In the Page Explorer, you also can duplicate pages (see *Rearranging and Duplicating Pages* on page 87).

**Cutting Pages**

Cutting a Whiteboard page removes the page from its room or group and places it in the clipboard. The clipboard is overwritten whenever you cut or copy another page.
Note: You can perform this function only in your private work area and you can move to your private work area only if you have been granted the page navigation permission by the Moderator.

To cut a Whiteboard page, do one of the following:

- With the Navigation toolbar, navigate to the page you wish to cut and then right-click (Control-Click on Mac) on the Whiteboard canvas to open the context menu. Select Current Page followed by Cut.
- In the Page Explorer, select the page(s) you wish to cut and right click (Control-Click on Mac) to open the context menu. Select Selected Pages and then select Cut.
- In the Page Explorer, select a page or pages and enter Ctrl+X (Command-X on a Mac).

You can now paste the cut page(s).

Copying Pages

Copy Page places a duplicate of the selected page in the clipboard. The clipboard is overwritten whenever you copy or cut another page.

To copy a page, do one of the following:

- Using the Navigation toolbar, navigate to the page you wish to copy and then right-click (Control-Click on Mac) on the Whiteboard canvas to open the context menu. Select Current Page and then choose Copy.
- In the Page Explorer, select the page(s) you wish to copy and then right-click (Control-Click on Mac) to open the context menu. Select Selected Pages and then select Copy.
- In the Page Explorer, select the page(s) you wish to copy and enter Ctrl+C (Command-C on a Mac).

You can now paste the copied page(s).

Pasting Pages

You must have previously cut or copied a page to have placed it in the clipboard. The last page(s) placed in the clipboard will be the page(s) that will be pasted. When pasting, you must identify one or more "target" pages in relation to which you want to paste the copied or cut page(s). If you identify more than one target page (e.g., three), the page(s) in the clipboard will be pasted once for each target page (e.g., in three places).

Note: You can perform this function only in your private work area and you can move to your private work area only if you have been granted the page navigation permission by the Moderator.
To paste a page, do one of the following:

- Using the Navigation toolbar, navigate to the target page and then right-click (Control-Click on Mac) on the Whiteboard canvas to open the context menu. Select Current Page, followed by Paste and then select a position for the page. The options are After, Before and At End.
- In the Page Explorer, select one or more target pages or groups and then right-click (Control-Click on Mac) to open the context menu. Select Selected Pages, select Paste, and then select a position for the pages. The options are After, Before and At End. If the pages in multiple page groups are selected, the page(s) in the clipboard will be pasted once to each room or group.
- In the Page Explorer, select one or more target pages or groups and enter Ctrl+V (Command-V on a Mac). The page(s) appear after the currently selected page(s) or at the end of the selected groups. If multiple pages or groups are selected, the page(s) in the clipboard will be pasted once to each room or group.

The page(s) appears in the selected position.

Deleting Pages

To delete a page permanently, do one of the following:

- Using the Whiteboard Action bar, navigate to the page you wish to delete and click Delete Page in the Whiteboard Action bar.

- Using the Navigation toolbar, navigate to the page you wish to delete and right-click (Control-Click on Mac) on the Whiteboard to open the context menu. Select Current Page and then Delete.

- In the Page Explorer, select the page(s) you wish to delete and press the Delete key.

- In the Page Explorer, select the page(s) you wish to delete and then right-click (Control-Click on Mac) to open the context menu. Select Selected Pages and then Delete.

You will be prompted to confirm whether or not you want to delete the page and its contents. Click Yes to complete the deletion.
Saving Whiteboard Pages

You can save the Whiteboard pages in Blackboard Collaborate web conferencing in the following formats:

- **WBD File** – When Whiteboard pages are saved as a Whiteboard file (.wbd), they are saved as one file that can only be imported and reviewed in a Blackboard Collaborate session.

- **WBP File** – When Whiteboard pages are saved as a Protected Whiteboard file (.wbp), they are saved as one file that can only be imported and reviewed in a Blackboard Collaborate session. These files are protected and cannot be printed, saved, or edited unless the Moderator removes the protection flag (by selecting Tools, then Whiteboard, and deselecting the command Protect Whiteboard).

- **PDF File** – When Whiteboard pages are saved as a PDF file (.pdf), they are saved as one file and can be reviewed outside of the Blackboard Collaborate environment.

- **PNG File** – When Whiteboard pages are saved as PNG files (.png), each page is saved as a separate image and can be loaded individually onto the Whiteboard as an image or used in an graphics editor application.

To save all or part of the Whiteboard, do the following:

1. If you want to save all pages in a room or group, navigate to that room or group. If you want to save a single page, navigate to that page. (See *Navigating Between Pages on page 87.*)

2. Open the Select Pages dialog by doing one of the following:
   - From the File menu, select Save followed by Whiteboard...
   - In the Page Explorer, select the page(s) and/or Group(s) you wish to save and then right-click (Control-Click on Mac) to open the context menu. Select Save...
   - Type Ctrl+S (Command-S on Mac). The Save dialog appears. Select Whiteboard and click on Save.
3. Choose whether you want to save **All Pages** in your current room or group, only the **Current Page** or **Selected Pages**. If you choose Selected Pages, a list of pages in the Whiteboard appears. Select the page(s) you wish to save. Use Shift or Control (same on Mac) to select multiple pages. Then click **OK**.

4. From the Save Whiteboard dialog, navigate to and open the file folder in which you want to save the Whiteboard.

5. Type a file name in the File name text box.

6. Scroll through the **Files of type** drop-down menu and choose the file format.

7. Click **Save** to save the file and close the Save Whiteboard dialog box.

**Printing Whiteboard Pages**

You can print individual pages, multiple selected pages and all the pages in a room or groups.

1. If you want to print all pages in a room or group, navigate to that room or group. If you want to print a single page, navigate to that page. (See **Navigating Between Pages** on page 87.)

2. Open the Select Pages dialog by doing one of the following:
   - From the **File** menu, select **Print** and then choose **Whiteboard**...
   - Enter Ctrl+P (Command-P on Mac). The Print dialog appears. Select Whiteboard and click on Print.

3. Choose whether you want to print **All Pages** in your current room or group, only the **Current Page** or **Selected Pages**. If you choose Selected Pages, a list of pages in the Whiteboard appears. Select the page(s) you wish to print. Use Shift or Control (same on Mac) to select multiple pages. Then click **OK**.

4. The Page Set-up dialog box opens. Specify your preferences and click **OK**.

---

**Note:** If the Whiteboard is protected, no one, including the Moderator, can print any pages.
Chapter 10

Application Sharing

Application Sharing enables session participants to share their applications or entire desktops with others in the session. Application Sharing is a type of content that, like the Whiteboard and Web Tour, appears in the Content area.

Note: Mobile device users cannot host or remotely control Application Sharing sessions, only view them. If you want to host an Application Sharing session, log in to the session from a desktop or laptop computer. For a list of features supported on mobile devices, see Attending Sessions on Mobile Devices on page 21.

You will know someone is hosting an Application Sharing session when the blue Application Sharing activity indicator (気軽 shows up next to their name in the Participants list. (For details on activity indicators, see Application Sharing Activity, Permission and Status Indicators on next page.) In the example below, Vivian is sharing an application or her desktop.
There are two conditions that need to be met before you can host an Application Sharing session: you must have been granted the Application Sharing permission and a Moderator must have switched to Application Sharing mode in the Content Area.

**Application Sharing Activity, Permission and Status Indicators**

You can monitor the state of Application Sharing activity and permissions through indicators displayed in the Participants list of the Participants panel.

**Activity and Permission Indicators**

The following table describes the icons displayed in the Participant list to indicate Moderator and Participant permissions and activity while using Application Sharing.

<table>
<thead>
<tr>
<th>Activity Indicator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>📝</td>
<td>User is conducting an Application Sharing session.</td>
</tr>
<tr>
<td>✗</td>
<td>Application Sharing permission is set globally to &quot;on&quot; but the Moderator has revoked Application Sharing permission from this user.</td>
</tr>
<tr>
<td>✔</td>
<td>Application Sharing permission is set globally to &quot;off&quot; but the Moderator has granted Application Sharing permission to this user.</td>
</tr>
</tbody>
</table>

**Status Indicators**

Status indicators appear on the Application Sharing activity indicator icons of people in the Participants list if they are experiencing delays in the receipt of Application Sharing content.

- **Amber Indicator**: Appears when receipt of Application Sharing content is moderately delayed.
- **Red Indicator**: Appears when receipt of Application Sharing content is significantly delayed. This may indicate a problem with the network connection and often will be followed by the user getting disconnected from the session.

>Note: Only the person currently hosting an Application Sharing session can see status indicators. Viewers do not see them.
In the example to the right,

- Lucy is sharing an application,
- Vivian is experiencing a moderate delay in receiving the Application Sharing content,
- Lisa is experiencing a significant delay in receiving the Application Sharing content, and
- Charlie is not having any problems receiving the Application Sharing content.

**Viewing a Shared Application**

Application Sharing is displayed in the Content area, which contains an Application Sharing Action bar in the upper left corner. For Participants without the Application Sharing permission, the bar contains the *Scale to Fit* option only (see *Scaling the Shared Content* below).

Participants who have the Application Sharing permission have the additional option *Request Cursor Control*. For information on this feature refer to *Requesting Control of an Application Share from the Host*.

**Scaling the Shared Content**

The application or desktop area shared by the Host can be scaled to fit the Content area (the default) or viewed at its native size (same size as the Host).

To view the content at the same size as the Host, do one of the following:

- Uncheck *Scale To Fit* in the Action bar.
- From the *Tools* menu, select *Application Sharing* and then uncheck *Scale to Fit*.

To restore scaling, recheck *Scale To Fit*. 

---

*Application Sharing* 97
Maximizing the Content Area

Another option you have for viewing an Application Share is to resize the Content area. You can optimize the space available in the Content area in two ways; for maximum space, do both:

- Maximize your Blackboard Collaborate web conferencing window.
- Hide the side bar (Audio & Video, Participants and Chat panels) by unselecting Show Side Bar in the View menu or by grabbing the border of any one of the panels and dragging it all the way to the left.

To restore the side bar, reselect Show Side Bar or drag the panel border back to the right.

Emphasized Cursor

If the application host has turned on the option Emphasize Cursor, you will see their cursor surrounded with a circle (the default color is yellow), making it easier for you to follow.

Hosting an Application Sharing Session

Application Sharing Mode

Before you can conduct an Application Sharing session, you must have been granted the Application Sharing permission and must switch to Application Sharing mode in the Content area. (For details on modes, see The Content Area Modes on page 16.)

Caution: Be careful not to inadvertently switch modes on someone else who is presenting content. Everyone in the session will follow you to the new mode.
Switch to Application Sharing Mode in one of the following ways:

- In the Collaboration toolbar, click the **Application Sharing Mode** button.
- In the *View* menu, select *Application Sharing*.
- Enter the keyboard shortcut Control+Alt+A (Command-Option-A on Mac).
- In the *Tools* menu, select *Application Sharing* followed by *Start Sharing*.
- From the *Tools* menu, select *Application Sharing* followed by *Share Entire Desktop*. This will start Application Sharing immediately without opening the Available Sharing Selections dialog.

When in Application Sharing mode, the Available Sharing Selections dialog will open.

**Starting an Application Share**

Before you can start an Application Sharing session, you must be in Application Sharing mode. For details, see *Application Sharing Mode* on previous page.

To start Application Sharing, do the following:

1. Open the Available Sharing Selections dialog by clicking on the **Start Sharing** button in the Action bar. (If you have the Hosting preference *Hide content area* turned on, the Action bar will not be visible.)
2. Click on **Share Desktop** or an available program window to select it. For programs with multiple available windows, click the arrow icon to expand the list if you wish to share only one window from the program.

You can share multiple applications or windows by selecting them using Shift or Control.

---

**Note:** Minimized (Windows) or docked (Mac) program windows will not be available to share.

---

3. Click **Share** to begin sharing, or **Cancel** to close the menu without starting a share.

If you wish to begin a new share after canceling, click the **Start Sharing** button in the Action bar. (If you have the Hosting preference *Hide content area* turned on, the Action bar will not be visible.)
4. Move the window you wish to share to the front of the desktop. Obscured windows or portions of windows will not be visible to remote Participants.

**Tip:** One helpful approach is to resize the window you intend to share so that it matches the dimensions and position of the Content area. That way you will be sure to have access to all of the Blackboard Collaborate web conferencing tools even while you are sharing.

The Application Share persists until it is closed or the host leaves the session. If a Moderator switches to Whiteboard or Web Tour mode, the share will still be active, but not visible until a Moderator switches back to Application Sharing mode. For more information refer to *Stopping an Application Share* on page 105.

**The Host's View of Application Sharing**

When you are the host of an Application Sharing session, by default your shared application or desktop will have a yellow border around it, making it easy to identify on your screen.

Attached to the border will be a controller (normally at the top but may move to the bottom, left side or right side if there is no room for it on the top) with buttons for stopping and pausing/resuming the application share and a button for sending a snapshot of the Application Sharing window to the Whiteboard. If the entire desktop is shared, the controller appears in the top right corner of the screen.

1. Host's Action bar
2. Stop Sharing button
3. Host's controller
4. Pause/Resume button
5. Send Snapshot to Whiteboard button
Controlling an Application Share

While running an Application Sharing session, a host can, for the most part, continue to use the program or desktop as usual. However, the Application Share itself can be stopped, paused, previewed, or captured.

**Caution:** If you are sharing an application that has a keyboard shortcut identical to one in Blackboard Collaborate, and focus is on Application Sharing, the shortcut will activate its associated command in the shared application, not in Blackboard Collaborate.

Pausing and Resuming an Application Share

A paused Application Share can be easily restarted later. To pause Application Sharing, do one of the following:

- In the Action bar, click **Pause Sharing**. (If you have the Hosting preference *Hide content area* turned on, the Action bar will not be visible.)

- From the *Tools* menu, select *Application Sharing* and then **Pause Application Sharing**.

- In the Host’s controller, click the **Pause** button.

- Switch to either Whiteboard mode or Web Tour mode. (For details, see *The Content Area Modes* on page 16.)

To resume Application Sharing, do one of the following:

- In the Action bar, click **Resume Sharing**. (If you have the Hosting preference *Hide content area* turned on, the Action bar will not be visible.)

- From the *Tools* menu, select *Application Sharing* and uncheck **Pause Application Sharing**.

- In the Host’s controller, re-click the **Pause** button.

Previewing an Application Share

Hosts can activate a small preview window to see how the shared application or desktop appears to others. This helps hosts know if part of a shared window is obscured or if the application share becomes frozen or lost.

To open the preview window, from the *Tools* menu select *Application Sharing* and then **Show Preview**.
**Taking a Snapshot**

Hosts can send a Snapshot of what is being shared to the Whiteboard. To capture an image and send it to the Whiteboard, do one of the following:

- Enter the keyboard shortcut, Control+Print Screen (Control-F13 on Mac).
- In the Host's controller, click the **Send Snapshot to Whiteboard** button.
- From the **Tools** menu, select **Application Sharing** and then
  - **Send Snapshot to Whiteboard**, to send an image of the current application share exactly as it is at that moment; or
  - **Send Snapshot to Whiteboard with Delay**, to take the Snapshot after a ten second delay.

Blackboard Collaborate web conferencing switches automatically to Whiteboard mode and pauses the Share until the host resumes it. The snapshot will be placed as the background image of a new Whiteboard slide, immediately after the current Whiteboard page. The title of the new page will be **Application Sharing Image x**, where x is an incremental number.

**Giving Control of an Application Share to Another**

Application Sharing hosts can let others in the session remotely control their (the host's) shared applications or desktops. When remotely controlling another’s application or desktop, you can move the mouse cursor, click, and type. The host of the application share also retains control at all times, and can revoke control from the remote controller at any time. Only the host and one other person can share control at once.

There are two ways for a person to remotely control your shared application or desktop:

- You can delegate control to them.
- They can request control from you, which you can reject or approve.

---

**Note:** Participants do not need the Application Sharing permission to take control if you delegate control to them.

When sharing an application window or a program, the remote participant's control is limited only to that application. The participant has no access to other areas of the host's desktop.

---

**Caution:** Be very careful when giving remote control access to your desktop as the remote controller has full user control over your computer. Do not leave your remotely controlled session unattended.
Delegating Remote Control
To pass control of an Application Share that you are hosting to another person, do one of the following:

- Right-click (Control-click on Mac) on the desired person in the Participants list and, from the context menu, select Give Control of Shared Applications.
- Open the Participant Options menu of the desired person in the Participants list and select Give Control of Shared Applications.
- Select the desired person in the Participants list. From the Tools menu select Application Sharing followed by Give Control of Shared Applications.

The person remotely controlling your Application Share will have joint control over your cursor until you revoke it (see Revoking Control on the facing page) or they voluntarily end their control (see Giving Control of an Application Share to Another on previous page).

Granting a Request for Control of an Application Share
Moderators and Participants with the Application Sharing permission can initiate a request for control of your shared application or desktop (see Requesting Control of an Application Share from the Host). When someone requests control, you will see the Remote Control Requested dialog appear on your screen:

- To allow a participant access to the desktop one time, click Yes.
- To allow future requests for control from any participant with the appropriate permissions without requiring approval, check Allow all other requests until I quit. This setting lasts until the host exits the session.
  
  To require a password from Participants who request control, enter the password in the field below. Participants who request control will be prompted for this password without notifying the host.
- To deny the Participant access to the desktop one time, click No.
**Caution:** Be very careful when giving remote control access to your desktop as the remote controller has full user control over your computer. Do not leave your remotely controlled session unattended.

**Revoking Control**

To revoke a person's ability to remotely control your Application Share (whether you delegated control or the person requested it), do one of the following:

- Type the keyboard shortcut for revoking control. The default is Control+Space (Command-Space on Mac).
- Right-click (Control-click on Mac) on the desired person in the Participants list and, from the context menu, select **Take Away Control of Shared Applications**.
- Open the Participant Options menu of the desired person in the Participants list and select **Take Away Control of Shared Applications**.
- From the **Tools** menu, select **Application Sharing** followed by **Take Away Control of Shared Applications**.

**Stopping an Application Share**

To stop an Application Sharing session, do one of the following:

- Enter the keyboard shortcut, Control+Shift+S (Control-Shift-S on Mac).
- In the Action bar, click **Stop Sharing**. (If you have the Hosting preference *Hide content area* turned on, the Action bar will not be visible.)
- From **Tools** menu, select **Application Sharing** followed by **Stop Sharing**.
Chapter 11

Web Tour

The Web Tour feature enables session participants to share web pages with others in the session. Web Tour is a type of content that, like the Whiteboard and Application Sharing, appears in the Content area.

Note: This feature is not supported on mobile devices. For a list of features that are supported, see Attending Sessions on Mobile Devices on page 21.

The Web Tour interface has the following components:

1 Collaboration toolbar
2 Navigation bar
3 Back button
4 Forward button
5 Address text box
6 Follow Me option
7 Options menu
You will know someone is hosting a Web Tour when the blue Web Tour activity indicator appears next to their name in the Participants list. (For details on activity indicators, see Web Tour Activity and Permission Indicators below.) In the example below, Vivian is hosting a Web Tour.

There are two conditions that need to be met before you can host a Web Tour: you must have been granted the Web Tour permission and a Moderator must have switched to Web Tour mode in the Content Area.

**Web Tour Mode**

Before you can conduct a Web Tour, you must have been granted the Web Tour permission and must switch to Web Tour mode in the Content area. (For details on modes, see The Content Area Modes on page 16.)

**Caution:** Be careful not to inadvertently switch modes on someone else who is presenting content. Everyone in the session will follow you to the new mode.

Switch to Web Tour Mode in one of the following ways:

- In the Collaboration toolbar, click the **Web Tour Mode** button.
- In the View menu select **Web Tour**.
- Enter the keyboard shortcut Ctrl+Alt+U (Command-Option-U on Mac).

**Web Tour Activity and Permission Indicators**

You can monitor the state of Web Tour activity and permissions through indicators displayed in the Participants list of the Participants panel. These indicators are described in the following table.

For details about permissions, see *Understanding Permissions* on page 24.
### Activity Indicator

<table>
<thead>
<tr>
<th>Activity Indicator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>User is conducting a Web Tour (or Web Push).</td>
</tr>
<tr>
<td>🖠</td>
<td>Web Tour permission is set globally to &quot;on&quot; but the Moderator has revoked Web Tour permission from this user.</td>
</tr>
<tr>
<td>🔄</td>
<td>Web Tour permission is set globally to &quot;off&quot; but the Moderator has granted Web Tour permission to this user.</td>
</tr>
</tbody>
</table>

### Starting a Web Tour

Before you can start a Web Tour, you must be in Web Tour mode. For details, see *Web Tour Mode* on previous page.

To start a Web Tour, do the following:

1. Select the *Follow Me* option if you want others to see the web pages to which you will be browsing. (For details, see *The Follow Me Option* on next page.)
2. Enter the URL of the desired web site in the Address text box of the Web Tour navigation bar.

   ![Address text box](https://example.com/address)

3. Press *Enter*.

### Conducting a Web Tour

Within the Web Tour, you can navigate through the current web site by clicking on links or can move to a different web site by entering a new URL in the Address text box. As you move between web pages, Web Tour maintains a history of where you have been. You can use the Back and Forward buttons to move between the pages kept in the history.

---

**Note:** Do not use Web Tour for password-protected web sites. Viewers of the web tour will not be able to follow you past the login screen. To share password-protected sites, use Application Sharing to share your desktop or web browser.
The Follow Me Option

By default, your Follow Me option is not selected and you will need to select it if you want others to view the web pages to which you will be browsing. With Follow Me selected, session attendees will be able to freely browse to other pages in the Web Tour, independent of the pages to which you, the tour guide, browse. However, when you move to a new page, they will be redirected to your new page.

Note: There is one exception: users cannot follow you to web pages protected by login credentials. They will see an error such as "The web page cannot be found."

If you don’t want to push them to your new pages, unselect the Follow Me option.

When you start a Web Tour, you are automatically the "tour guide". However, a Moderator, or Participant with the Web Tour permission, can take control of the Web Tour by selecting their Follow Me option. Your Follow Me option will be unselected. You can take back control by selecting it again.

Publishing URL to Chat Panel

Moderators, and Participants with the Web Tour permission, can publish the URL of the current web page to the Chat Conversation pane so it is accessible to (clickable by) everyone. To do so, select Publish URL to Chat from the Web Tour Options menu.

Stopping the Web Tour

To stop the Web Tour, do one of the following:

- Unselect the Follow Me option.
- Switch to Whiteboard mode. (For details, see The Content Area Modes on page 16.)

Viewing a Web Tour

A Web Tour is a type of content, and appears in the Content area like the Whiteboard and Application Sharing.
Once someone starts a Web Tour, you can freely navigate to other pages within the website by clicking on links or using the Back and Forward buttons. However, if the Host of the Web Tour has selected the *Follow Me* option, you will be redirected to the Host’s current page whenever the Host moves to a new page.

---

**Note:** There is one exception: you cannot follow the Host to web pages protected by login credentials. You will see an error such as "The web page cannot be found."

---

For more information on Follow Me, see *The Follow Me Option* on previous page.

**Optimizing the Content Area**

The Web Tour content often may not fit into your Content area so you will have to use the scroll bars to view web pages.

You can optimize the space available in the Content area in two ways; for maximum space, do both:

- Maximize your Blackboard Collaborate web conferencing window.
- Hide the side bar (Audio & Video, Participants and Chat panels) by unselecting *Show Side Bar* in the *View* menu or by grabbing the border of any one of the panels and dragging it all the way to the left.

To restore the side bar, reselect *Show Side Bar* or drag the panel border back to the right.
Chapter 12

Interactive Recordings

While watching a recording of a Blackboard Collaborate web conferencing session, you may have opportunities to interact with the recording. You may receive a file from the session Moderator through the File Transfer facility, be prompted to take a Quiz, or be able to navigate to web pages in Web Tour.

Moderators can record sessions and provide you with a link to the recording so you can play the recording. This is useful for those who have missed a session or to those who attended but would like to review the session.

**Note:** Interactive recordings cannot be watched on mobile devices, however, recordings can be converted to MP3 and MP4 formats, which can be viewed on mobile devices. However, not all institutions support conversion of recordings to MP3 and MP4 formats, so consult your system administrator for details.

All activity that occurs in the Main room of the session will be recorded, except for private Chat messages, the Timer and personal Notes. (Only the activity in the main Blackboard Collaborate web conferencing room will be recorded. Anything that occurs in a breakout room will not be recorded.)

As the recording progresses, Blackboard Collaborate inserts index entries to mark significant events within the session. Anyone viewing the recording can navigate through the recording to points marked with index entries.

You can tell that a session is being recorded in two ways:
A red Recording icon appears in the Collaboration toolbar.

The audible notification “Recording started” is played. (If you are using the telephone for audio communications, you will not hear it.)

**Note:** If you join the session after recording has already resumed, you will hear the audible notification “Recording in progress.”

**Playing a Recording**

A recording is played by clicking on a recording link. Access to recordings will be dependent on your organization’s administrative interface. Please contact your administrator for more information on accessing recording links.

To open the recording, click on the recording link. A Blackboard Collaborate web conferencing window will open. Use the Playback Controller panel at the bottom the window to start, stop, pause/resume and navigate through the recording.

1. Play/Pause button
2. Index Entry marks
3. Playback Slider indicator
4. Current Index Entry
5. Show Index Entry Menu button
6. Playback Time indicator
7. Playback slider
8. Total Recording Time

**To play a recording or resume a paused a recording:**

- Click the **Play** button (to play at normal speed).
- From the **Playback** menu, select **Player** and then **Play** (to play at normal speed).
- From the **Playback** menu, select **Player** and then **Fast Forward** (to play at an accelerated speed).
As the recording advances, the Playback Time indicator, the Current Index Entry Mark and the Playback slider will show your progress through the recording.

**To pause the recording:**

- Click the **Pause** button to stop playing the recording and maintain your current place in the recording.
- From the **Playback** menu, select **Player** and then **Pause**.

**To stop the recording:**

From the **Playback** menu, select **Player** and then **Stop**. When you stop a recording, you will not maintain your current place in the recording – the recording goes back to the beginning.
Blackboard Collaborate Copyright

This document contains confidential proprietary information and is protected by law. This document and the information contained in it are intended for authorized users only and may be used only for the express purpose of legally accessing and using Blackboard Inc. products; any other use, without Blackboard Inc.’s prior written permission, is strictly prohibited.

© 2013 Blackboard Inc. All Rights Reserved.

Trademarks

Blackboard, the Blackboard logo, Blackboard Collaborate, the Blackboard Collaborate logo, Behind the Blackboard, Wimba and Elluminate are trademarks or registered trademarks of Blackboard Inc. or its subsidiaries in the United States and/or other countries. All rights reserved.

All other brand or product names are trademarks or registered trademarks of their respective companies or organizations.